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About MovieRecorder 4

MovieRecorder (MR) is a macOS application that allows you to record almost any video clip
with a large range of resolution and codecs. A reliable tool for the most demanding
productions: sports, music, multi camera productions, news, REMI, corporate events-houses
of worship...

Simplicity
The User Interface has been designed to be easy to use. It is the key of MovieRecorder’s
success.

Flexibility

MovieRecorder is also very flexible, it supports multiple formats (SD, HD, 4K or 8K) and a
wide range of codecs. It integrates easily with past, present and future systems. Boasting a
wide range of features such as edit-while-ingest (growing files), multi channel recordings,
multi destinations, external audio, NDI, HDR, timecode, and remote control make this
recording solution a crucial part of your workflow.

Security

MovieRecorder 4 is based on a macOS architecture which is known for reliability and
flexibility. All solutions developed by Softron Media Services are fully tested and approved
before released. Prompt and personalized support is also what we do best.

MovieRecorder 4 is a very intuitive program with a lot of features and functions. What follows
is a brief explanation of how to use the application, beginning with installation instructions,
followed by a description of the User Interface and then with instructions on how to get the
most from the application.

In addition to this user manual, you can also find a lot of information:
. on our website: www.softron.tv; at the bottom of the MovieRecorder page, you will find:
- http://softron.tv/downloads: to download the latest version of MovieRecorder

- Resources: where you most probably found this manual, but also with some
Sample AppleScripts and other White Papers

- Tech Specs: where you will find recommendations on what you need, what drivers
to use, what video cards and codecs are compatible, etc.

. in our Release notes.

. on our support desk, there a lot of information is available in the help center.

. on our YouTube channel,

. and don’t forget to follow us on Twitter and Facebook for the latest Softron news.
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What’s new in MovieRecorder 4.5 ?
With the release of MovieRecorder 4.5, a couple changes were made:

* Scheduled Recordings: Added a webpage to view and edit the scheduled
recordings.

* AV Presets: Added support for audio track languages and DV codecs.
* Videohub Control: Added the "directly" method in AppleScript.
* Metadata: Possible crash when editing metadata in preferences.

* AVID DNx: Added native support for DNxHD and DNxHR with Apple Silicon
computers.

* Deltacast devices: Added support for Rec. 2020 Wide Gamut and HDR (HLG & PQ).

* Blackmagic-Design: Added support for up to 64 audio channels (with supported
devices).

* AVID DNx: Added native support for DNxHD and DNxHR with Apple Silicon
computers.

* Scheduled Recordings: There would be a warning with AppleScripts missing while
they were not.

* Videohub Control: Added the "directly" method in AppleScript

* RS422 Timecode: Potential issues with negative values when using fractional frame
rates.

... And many new features on their way !

What’s coming in MovieRecorder 4.6 ?
. The High Frame Rate option

To see the latest news and all the details, go to our Softron website.
If you want to submit a request, contact our support team, always ready to help you.
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Main differences between MovieRecorder Express and
MovieRecorder

Important Note: In this document, to keep things simple, we will mainly use the word
"MovieRecorder". We will just indicate which features are only for MovieRecorder, so if you
are using MovieRecorder Express you can skip these parts.

We offer two versions of our ingest application. MovieRecorder Express is the "entry-level"
ingest solution from Softron, while MovieRecorder offers more advanced features.

You can compare the two versions in the feature list of the MovieRecorder page on our
website.

But here are a few explanations on the main differences:

* Multiple Destinations: Record to multiple destinations at once so you can, for
example, record to 2 different storage devices for redundancy, and/or record to 2
different codecs.

* Supported Codecs: In addition to ProRes, H.264 and HEVC, MovieRecorder can also
record to AVC-Intra, DV/DVCPRO, DVCPRO HD, DNxHD, HDV, IMX andXDCAM.

* Supported Wrappers: MovieRecorder can record to MXF (Op1a), as well as QT.

* Closed Captioning: If a valid CC signal is detected on the input, a CC icon will be
displayed. Record CEA-608 or CEA-708 Closed captioning tracks.

* Metadata: Add metadata to the recorded file, either as a side car file or embedded in
the movie (the embedded option is available only in QuickTime).

* External audio sources: Instead of using the audio input of the video device (AJA,
Blackmagic-Design, Deltacast), use external audio, such as the built-in audio input of
the Mac, or Dante audio, etc.

* Effects and Overlays: In AVPresets, you can choose to rotate, crop, scale, overlay
TC, Text, and/or a graphic (such as your logo).

* Save and restore configurations

* VTR Control and batch capture: Control a VTR with an RS422 port, create batch
lists, and capture them. Ideal if you have a lot of tapes to capture.

* Remote Source "Slave" mode: You can set a remote source to do exactly the same
thing as the source you are controlling. This is a great solution for redundancy, so
you can have multiple computers start and stop recording at the same time.
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Before Installation

If you use a video device from AJA, Blackmagic Design or Deltacast, make sure the device is
physically connected. Double check that all cables and hardware are installed correctly.

Also check that you have the appropriate version of the driver and OS:

1. On the Softron website, check which driver and OS is recommended for your card.

2. Download the appropriate driver from the AJA, Blackmagic-Design or Deltacast website.
3. Make sure you use a compatible version of Mac OS

Once the drivers are installed, verify the settings of your card using the Preference pane or
control application (if applicable) included with the hardware. For example, with a
Blackmagic-Design card, you may want to change whether the input is through the SDI or
the HDMI connector.

Software Installation

1. Download the software from our website .
2. Unzip the downloaded file.

3. Drag and drop the MovieRecorder (or MovieRecorder Express) application into your
applications folder.

First Start

1. Double click on the MovieRecorder icon or select the icon in the Applications folder and
use your File > Open command to launch the application.

2. When prompted with the message that “MovieRecorder.app is an application
downloaded from the Internet. Are you sure you want to open it?” Click on Open.

3. Alicense agreement window will open. Enter your name and email address for the
registration. Tick the check-box and click on “Accept.”

4. Enter an admin password to install the required components.

5. If you have a dongle connected to the computer with valid licenses for MovieRecorder,
the application will start right away.

6. If you do not have a dongle connected, a license window will open to offer you three
choices:

« Register: if you own a serial number, click on this button and follow the
procedure to activate it. You can read more about the activation procedures on
our support desk.

« Buy: if you don’t have a serial number, but want to buy one, click on that button.

- Demo: if you want to try the application in DEMO mode, click here. In DEMO
mode, MovieRecorder is fully functional. The only limitation is that a blue frame
will be written to the file every few seconds.

Note that the license window will only open the first time you start the application. If you
want to add a license, or upgrade later on, you can access the license window in the
Menu “MovieRecorder 4 > License..”

7. That's it — you are ready to use MovieRecorder 4!

SOFTRGON 7.
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1. Overview of the User Interface
There are three windows in MovieRecorder:

. The "Main" window where you can setup and control MovieRecorder
. The "Activity & Logs" window
. The “Stream Deck” window

11. The Main Window

In the main window of MovieRecorder, there are three areas:

The left panel with the list and configuration of:
- the Sources (Local and Remote)
« the Destinations

The center area with the multiple "Viewers" where you can preview and control
the different Sources

e The right panel where you can:
. Create and edit Scheduled Recordings

. Control VTRs and create batch lists (not available in MovieRecorder
Express)

DELTA-hd - 1

071:28:56:03 _

DaD oD DD o> oD D

MR4 Manual X 3 1080i 59.94
jes  DELTA-hd -7

1080i59.94 LU 1080i 59.94
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1.2. The Activity and Logs Window

In the Activity and Logs window there are two areas:

1. Atthe top is the "Activity" area where there are many different gauges that offer
a quick view of how the different computers, sources and destinations perform. If
you see some gauges filling up and getting red, it is usually not a good thing. For
an explanation of what each gauge means, you can hover your mouse on any of
them and a Tooltip should appear with a brief explanation. We also have an
article in our Help Center that explains more about this.

2. Below is the "Logs" area where you may see important warnings. If anything
issues arise during the recording, you will see some messages or warnings there.
Note that you can filter what is seen by using the search field at the top right of
the area.

There are also a few options at the bottom of this window:

«  Show on Error: when enabled, the log window will automatically open when
there is a log shown in the lower area. Leave it enabled if you want to be warned
about possible issues. Disable it if you don’t want to be disturbed.

« Now: the log area will always show you the latest log.

- Reset Warnings: Clears the logs, as well as all attention signs that were shown
on sources or destinations (unless they are permanent warnings such as a
Volume not mounted for a destination)

« Search: Allows you to search for a specific logs in the logs shown.

[ ] Activity

v This Computer
~ 8KPro_A_01

QuickTime Destination Apple ProRes 422 12003 GB
MXF Destination XDCAM HD 422
Streaming Destination N/A

v DELTA-12G -1

QuickTime Destination Apple ProRes 422 12003 GB
MXF Destination XDCAM HD 422
Streaming Destination N/A

v Konab-8K-1-1

QuickTime Destination Apple ProRes 422 12003 GB
MXF Destination XDCAM HD 422

Streaming Destination N/A

Logs

SOFTRGON 9-
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1.3. The Stream Deck Window

There are two sections in the window:

1. To the left is the list of available pages, with their names and which kind of
Stream Deck device they are for.

2. To the right is the list of Stream Deck devices that are connected to your
computer. On the screenshot below, there is a "Classic" and a “Mini”.

[ N ) Stream Deck

Device Type:
All Types

(® sTREAM DECK
Default (© STREAM DECK
Classic

Launch Clips
Default

Stream Deck Classic (AL44G1A08592) Stream Deck Mini (BL36H1A26332)
Launch Clips

Default

Launch Clips

The explanations on how to use these three windows are coming in the chapter “Stream
Deck”

2. Enable and Set Up Sources

The Sources tab is where you will select the sources (or inputs) from which you will be
recording. There are three kinds: Local Sources, NDI Sources and Remote Sources.

2.1. Local Sources

Local Sources are video devices that are connected directly to your Mac. You can connect
most AJA or Blackmagic-Design devices, as well as our MIFamily devices (MI8e, MI8i, Ml4e,

and Ml4i). Depending on the type of device that you connect, you will be able to see more

or less Sources. Some devices can have multiple inputs, while others have just one. Check

our website for the list of compatible video devices.

SOFTRGON 10-
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211. Enable Sources Sources
v Local Sources
Any sources connected to your system will v Delta-hd 1
automatically show up in the Local Sources section,
provided their driver is installed (and up-to-date). ¥ Delta-hd 2

The sources will be given a default name, based on
the device name and the number of the input, but
you can always rename them either:

. in the Sources list directly (click on the name and leave the mouse for a few seconds)
. in the setup window, accessed by clicking on the gear icon, in the "Source Name" field.

v Delta-hd 3

Note that sources are sorted using the "Source Name” but you can also sort them using the
default device name. To change the sort method, right click on the Sources list and select
either "Sort by name" or "Sort by device”.

If the device does not show up, check that:

. The device is properly plugged in.

. The drivers for your device are properly installed. You can download drivers
from the manufacturer’s website. Here are the links to AJA, and Blackmagic-
Design. For Deltacast, we recommend downloading from our website as we
will validate them.

. Make sure that the appropriate version of the drivers are installed (if not, you
should see a warning in the Logs area of the "Activity and Logs" window).

. Some devices (AJA and Ml

Family) will only show up if ece Privacy & Security
they are connected before the  a ey
. . P All licati di loaded fi
application starts. If you gy DonlELTHOIE i
. © App Store and identified developers
connect the device after Sotware pste @

Some system software requires your attention before it can be used.

MovieRecorder started, it will

. Wi-Fi Details...
not show up. Quit and restart g o..oon
MovieRecorder to see them. @ Network &) Filevault off
. You have allowed the == Notfications O Lockdown Mode off
. . &) Ssound
extension to load in "System 9 Focus
Others
Preferences > Privacy & @ screen Time N
Security." (3 ceneral

@ \/J Profiles
Appearance et

Accessibility

L) Control Centre

Advanced... ?

S
To use a source, just enable the appropriate box in front of the i

Source’s name.

¥ Local Sources

¥ |Delta-hd 1
¥ Delta-hd 2
¥ Delta-hd 3

¥ Delta-hd 4

A
o
A
L
A
£
A
L
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21.2. Setting up Local Sources (all)

To set up a source, either: @ DEITA-196 -1 A
Input Name. Click to edt. ;o yuy g-bit) &%

* Click on the "gear" icon
* Double-click on the Source cell
* Right-click on the source cell and (there’s

Source Name: | DELTA-12G - 1

Video Settings

an extra space here) select "Edit Settings" Video Format: @ Automatically detect input format
Pixel Format: | YUV 8 bits &
This will open a popover window wherein you Color Space: (ENEEEENNS
can change a number of settings, including the ¥ Enable Captions & VANCs
Source Name, as well as the Video, Audio and Audio Settings
Timecode Settings. Source: | Video Device Audio

Audio Channels: |16
Sample Size: |16

Depending on the type of device that you use, e

the layout and options might differ slightly. For Source: | Application Timecode
all devices you will be able to configure the Offset: 0 @ frames
following settings.

" If a source refuses to enable and show a warning icon, click on the warning icon.
This will show the ‘Activity and Logs" window. Check the logs area for a possible
explanation. The most common reasons for that are:

. The device is already in use by another application
. The device is not properly configured
. You do not have enough licenses (you need one license per source/channel)

21.21. Video Settings

. Video Settings:
. Automatically detect the input v DELTA-12G - 1 A
format: This is very useful if you are Rl 2ck el Rz RiesE B
changing a lot across different types of
video formats. If the above option is
disabled, you will have to manually Video Settings
SeleCt the incoming Video format in the Video Format: ¥ Automatically detect input format

opup menu below.
popup Pixel Format: | YUV 8 bits )

Source Name: | DELTA-12G - 1

. Pixel Format: Choose between YUV 8, ——
10 bits or ARGB. ¥ Enable Captions & VANCs
. Color Space: Choose between Auto Audio Settings
Detect, REC 601, 609 or 2020. Source: Video Device Audio
. Enable Captions & VANCs: Allows R EEIIEEE
Closed captioning and other datas SRS
(Metadata, timecode, SCTE...) Timecode Settings
Source: Application Timecode
Offset: 0 C frames
SOFTR®N 12-
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~ . The available input video and pixel formats depend on the type of video device
used. If you don’t see a video or pixel format in the popup menus, it means that
your video device does not support it. Check with the device manufacturer.

. If you don’t change the video format often, we would recommend to disable the
auto detect feature. Indeed, some video device can be sensitive and sometimes
report a format change when there was not, or when there are instability in the
signal, it can also have some weird behaviors.

. Setting with NDI sources:
. Frame rate is not constant: When Enable, it allows MovieRecorder to handle better
Frame rate with softwares like NDI Scan Converter.

2.1.2.2. Audio Settings

First you will be able to select the Audio Source. Either:
. Video Device Audio: when you want to record the audio that gets in the video
device that you use. Depending on the type of device you use, it will either be the
audio embedded in the SDI, or analog audio if your device supports that.

. External Audio Sources: when you want to record the audio coming from a
different source than the video device (not available in MovieRecorder Express).

MovieRecorder (not MovieRecorder Express) can use any audio sources that are visible to
the macOS as an external audio source. It can be a built-in audio input on your Mac, or a
USB audio device that you have connected to your Mac, and it can even support IP audio
protocols, such as Dante, which is very useful in today’s workflows. Basically, if you see an
audio input in the System “Settings > Sound > Inputs pane”, you should be able to use it in
MovieRecorder.

To see the available audio sources, click on the popup menu "Sources" in the Audio Settings
of the sources settings popover:
Source Name: = SourceFP=Default

Video Settings
Video Mode: | 1080p 60

. Sample Size (the available sample sizes presented

depend on the type of device used). S —
. Delay Offset: Necessary f there is a disparity

between the audio and video signals. The delay is Audio Settings

in frames, and will delay the audio for the amount of Source R

Audio Channels

frames set there. This is even more useful if you use
an external audio source as the Video and Audio F—

) A ) . i A ) ) alaxy Buds2 (A447)
pipelines will be different and usually audio will Timecode Setting  np) Audio
arrive quicker than video, and thus you will need to By
add a delay.

Sample Size

Offset: frames

Note that you cannot map audio in the sources settings. If you need it, this is done in the
AVPresets settings, using custom presets. The reason it is done in AVPresets (and thus
relative to destinations) is so you may have different audio mapping for different destinations
(for example, for users with multiple languages).

SOFTRGON 13-
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2.1.2.3. Timecode Settings ¥ Delta-hd 1 ®
fol

v Delt

For each source, you can choose between: source Name: (HERENE
. Video card timecode (when it is the video device K& Video Settings
that provides the TC) o Video Moce:. (N
. Application timecode (when the video device B
does not provide the TC and it is retrieved by an A -
. . . . emote udio Settings
external device such as an audio input for Audio Source: (VideSIDEVIGEALAR
LTC) Audio Channels: | 64

Sample Size: |16

NDI Sou

Timecode Settings
Source v Application timecode

Offsel Video card timecode

Bluetooth-Incoming-Port

The video card timecode uses the timecode that is provided by the video device (there is no
need then to setup anything in the MovieRecorder preferences). The type of Timecode
available on the device will depend on the type of device used. Typically there may be a few
timecode sources available on the device:

. Embedded Timecode. Is the timecode that is embedded in the SDI signal, either in
RP188, LTC, VITC...

. Audio LTC Timecode. Some devices (check on the manufacturers website) have a
timecode input. Usually it is either an XLR or BNC connector that will receive an Audio
LTC timecode signal (how to set up Audio LTC). If you want the video card to read the
timecode from that connector, you have to open either "AJA Control Panel" or
"Blackmagic Desktop Video Setup" applications to set it up:

L 104KPlus - AJA ControlPanel - X o0 0 Blackmagic Desktop Video Setup

UltraStudio 4K

UltraStudio 4K

Video Audio Conversions

Video Input

. 4K Quarter
Playback gliQuaner
Video Output
Format
Output Format: | NTSC
LTC Port

SDI Settings: 4:4:4 RGB

1080PSF On v/ Remove Field Jitter On Pause

SDI Configuration: singletink @) Dual Link

Cancel

The Application Timecode uses the timecode that is set in the settings of MovieRecorder. To
change the application timecode source, go in the settings of MovieRecorder and select the
"Timecode" pane:
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In the first dropdown menu, you can choose from four timecode sources for the application
timecode:

. Audio LTC: select the audio
input on which the Audio LTC
(how to set up Audio LTC) is
received. You will be able to
use the same audio inputs that S
are available for your system Audio LTC Inpui TCS :PULSE (Network)
audio, as well as all the channe,  TCS Ultrasync Blue (Bluetooth)
sources that are set to use
“Video card Timecode" (to use
the timecode of a given source
for all sources at the same
time, see Timecode "Sharing"
below for more info on this)
Mac Clock: will simply use the
time of day of your Mac to
generate a timecode
TCS :PULSE (Network): use Timecode Systems products via WiFi or Ethernet. You can
read more about this the following help center article.

TCS UltraSync Blue (Bluetooth): use Timecode Systems products via Bluetooth. You
can read more about this the following help center article.

Settings

Q

General A/V Presets Metadata ] Actions

Mac Clock

Frames Per Second: | 29.97 fps <

~— When using a video device with an Audio LTC timecode input, always
select “Video card timecode" to use the timecode input. A common
mistake is to select "Application timecode" and then in the MovieRecorder
preference to select "Audio LTC" and then select the video card. This won’t
work. You can information about how to set up Audio LTC in our website.

21.2.4. Timecode "Sharing"

In MovieRecorder 4 it is possible to share the Timecode of a source with other sources. So,
for example, if you use an MI8, you can have only one SDI input with embedded TC and
share it with all eight sources. Or with an AJA lo 4K to share the RS422 timecode input with
the other inputs. This reduces the requirement to have a TC embedded for each signal.

This is a two step process:
. Make sure that at least one source uses "Video Card Timecode" (and not Application
Timecode):

Timecode Settings

Source v Application timecode

Offset Video card timecode

. Then go to the MovieRecorder Settings, and you should now see the source as a
possible Application Timecode Source.
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2.1.3. Specifics of “Blackmagic Design" Sources

With Blackmagic Design, the popup to set up the sources should look something like this.
If you need to change other settings than the ones shown there, use the "Blackmagic
Desktop Video Setup" application. For example, you might:

Q

. Select if you want to automatically B 8KPro_A_01
DeckLink 8K Pro...V 8-bit Rec 709) £}

detect input format (if for example
your device has a SDI and HDMI

Source Name: | 8KPro_A_01

input).
. Video Settings
. Enable downscaling on one of the ) _ ‘ _
. Video Format: W Automatically detect input format
inputs.
. Set if you want to use p or psf, Pixel Format: (YUV/8bits|

Color Space: | Auto Detect <

. Set if you want to use the available -
¥ Enable Captions & VANCs

timecode input.
" H n
. Set the Co.nnector Mapping" on Source: (Video|Device/Audio
Certa|n deV|CeS. Audio Channels: |16

Audio Settings

Sample Size: | 32
Timecode Settings
Source: | Video card timecode

Offset: 0  frames

Incoming TC is 25.00 FPS

Decin=izo = o yAaY

2.1.4. Specifics of "Deltacast" Sources (Hardware bundles)

If you are using an MI80, MI62 or MI40 (or their 3G “X” equivalents, such as the MI80X), then
all the setup happens in MovieRecorder, and there is nothing to be configured elsewhere.

You can find a lot of information DELTA-12G - 1 A
bout Deltacast card on our o
Support desk. Such as:

Source Name: ' DELTA-12G - 1

« HOW TO: Know which version of

Video Settings

Deltacast Drivers is installed Video Format: ¥ Automatically detect input format
Force 16:9
. HOW TO: Update the firmware on Pixel Format: | YUV 8 bits &
a Deltacast card Color Space: | Auto Detect ]
v Enable Captions & VANCs
« HOW TO: Change the Audio Settings
configuration of some Deltacast Source: (VidEoIDEVIceIALGI0

cards Audio Channels: [16 B

A

Sample Size: 16 <

Timecode Settings

Source: Application Timecode

Offset: 0 C frames
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21.5. Specifics of "AJA" Sources

With AJA there are a few more settings to configure in MovieRecorder:

Kona5-8K - 1-1
Kona5-8K - 0 - 1...UV 8-bit Rec 601) {}

K

Source Name: Kona5-8K-1-1

Video Settings
Input: | SDI <

Video Format: & Automatically detect input format

Single Link ¢ W Level A

Format:
Mode:
Pixel Format: | YUV 8 bits
Color Space: | Rec 601
¥ Acquire Card
« Enable Captions & VANCs

Audio Settings
Source: | Embedded

Audio Channels: ' 8

Sample Size: 32

Timecode Settings

Source: | Application timecode

Offset: 0 £ frames

Indeed, the AJA Control Panel application is not really intended for independently
addressing the multiple channels of some AJA devices, such as the four channels of an AJA
lo 4K or a Corvid 88. In AJA Control Panel, you will only set the following things:

. the source of the reference signal

. the timecode source.

All the other settings will be done directly in MovieRecorder, so do not worry about setting
the frame buffer format, etc... In addition to the "regular” settings regarding the video format,
etc, for AJA devices you will be able to set:

. HDMI: Some AJA devices have an HDMI output, but, for example, the lo 4K has just
one HDMI input, but four sources available. This sets which input you should use for
the HDMI input instead of the SDI input.

. Up/Down Conversion: Sets the up or down conversion that will be done. Note that if
your device has a Ufc and 4K firmware (as does the lo 4K), up and downscaling may
only be available when the card is loaded with the "Ufc firmware,” and thus have only
two inputs.

. Acquire card: if enabled, only MovieRecorder will be able to use the device, so you
won’t be able to use it with OnTheAir Video, for example. It is recommended to leave
this on so other applications will not interfere.

There are other things to know about using MovieRecorder 4 with AJA devices, and we
recommend reading the following article.
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2.2. NDI® Sources

2.21. Setting Up NDI® Sources

MovieRecorder is compatible with NewTek’s

. . ([
Network Device Interface, or NDI®, allowing you
to access sources connected over IP, via an Sources
Ethernet cable. To add an NDI Source, first click » Local Sources

on the “+” icon to the right of the NDI Sources ¥ NDI Sources

section on the Sources panel. -

» Remc
Doing so pops up a window listing all NDI |

Sources available on the network. Enable
whichever ones you'd like to be able to use,
and it will then show in the sources list and you
can then enable the sources the same way you
enable a Local Source. Note that NDI sources
can take a few seconds to receive the signal.

If you click on the gear icon to adjust v NDI Sources

TRICASTER-MINI (IN 1)
TRICASTER-MINI (IN 2)
TRICASTER-MINI (IN 3)
TRICASTER-MINI (IN 4)

TRICASTER-MINI (MIX 1)
TRICASTER-MINI (MIX 2)
TRICASTER-MINI (MIX 3)
TRICASTER-MINI (MIX 4)

some of the settings, you may only MS1ULT...ir Video) NI

change the Source Name, but not the
Video Mode, the Pixel Format, and the
number of Audio Channels, as these Source Name:
depend on what we receive from the NDI Video Settings
source. Video Mode:

Pixel Format:

Audio Settings

Source:
Audio Channels:

Sample Size:

Timecode Settings

Source:

SOFTRGON
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2.3. Remote Controlled Sources

You may also access sources that are not directly connected to your Mac. For example, you
can control multiple MovieRecorder 4 applications remotely. We have customers who have
up to 49 inputs in their facility, and they can all control them from just one computer and one
screen.

You can use a demo version of MovieRecorder to control another MovieRecorder, as you
only need to pay the license for an actual source.

To know how to control Remote sources, go to chapter “Control Remote Sources”.

2.31. Set Up the MovieRecorder you Want to Control

Before doing anything, first check on the computer that you want to control that the "Remote
Control" option is enabled.

&3

General

Preview Quality: & High Quality = Refresh Rate: | Every Frame

« Deinterlace

Technical Log Level: | Info (default) ¢ Action: | <None>

Remote Control
¥ Remote Control
Name: remis-macbook-pro Reset
Port Number: 8080 Require Password Set Pwd...

Web Pages Folder: Select...

You may also want to check:

. Name: the name under which you will see it in the MovieRecorder that will control it.
The default name is the Mac Bonjour Name, but you can change it to whatever you
like, provided it is unique. If you named two or more MovieRecorders the same way,
there will be a conflict, and you won’t know which one you control.

. Port Number: the default is 8080, but if that port is not available in your network
because the Firewall blocks it, you can change that value

. Web pages Folder: If you have created one or several web pages to interact with
MovieRecroder, you can select the folder containing those pages and it will be hosted
by the application. For instance, a page called "Custom.html" in a folder selected could
be reached at 127.0.0.1:8080/Custom.htm/

. Password: sets whether the password is required or not. Enabled, only the individuals
with the password can control MovieRecorder.

I You may need to quit and restart MovieRecorder after you change any of those
settings.
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2.3.2. Adding Remote Sources with “Bonjour”

Now that your MovieRecorder on "Computer A" is ready to be controlled, open
MovieRecorder on "Computer B" (as a reminder, it can be a demo version), and simply click
on the + icon at on the bottom left of the Remote Sources panel. A pop-up window will
appear.

If "Computer B" is located in the same local area network as "Computer A,” you will see it
listed with the name you have specified in its preferences. Double-click on the name of the
Computer you want to control, it will then be added to the list:

Sources
» Local Sources
» NDI Sources

¥ Remote Controlled

P ibs-mac-
ibs-mac-pro

Add by Address...

Then if you click on the “Disclosure" icon, it will show the list of sources available remotely:

Sources
» Local Sources
» NDI Sources
¥ Remote Controlled

V¥ ibs-mac-pro

DELTA-hd - 7
DELTA-hd -1
DELTA-hd - 2
DELTA-hd - 3
DELTA-hd - 5
DELTA-hd - 6
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You can then use the remote sources the same way you use local sources (with some
limitations; see below). You can either drag and drop a source name to a Viewer or select it
in the Viewers Source selection menu:

Sources
» Local Sources
» NDI Sources

V¥ Remote Controlled

V¥ ibs-mac-pro

DELTA-hd - 1

DELTA-hd - 2

DELTA-hd - 3

DELTA-hd - 5

DELTA-hd - 6

DELTA-hd - 7 DELTA-hd - 1
DELTA-hd - 2
DELTA-hd - 3
DELTA-hd - 5
DELTA-hd - 6
DELTA-hd - 7

v Select a Source...

2.3.3. Adding Remote Sources with a Manual IP Address

If your Mac does not show up in the list, it
may be that you are not in the same

subnet, and you will have to add the Sources
remote computer using its IP address. To - el bl
do so, click on the “Add by Address...” » NDI Sources
button. ¥ Remote Controlled

P ibs-mac-

Another window will pop up; enter the IP ibs-mac-pro

Address there.

Remote Movie Recorder

IP Address:  0.0.0.0

Add by Address...

Port: 8080

Cancel
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2.3.4. Working with Password Protected Remote Sources

If on Computer A you have required a password to be able to connect to it, there will be an
additional window that will pop up when you connect:

Enter your password to be able to control the
remote sources on

Password:

¥ Save in my keychain

Cancel Connect

Enter the password that you have specified and, optionally, save it in the keychain. If you
save it, the next time you start MovieRecorder, you won’t have to enter the password
anymore to control it — but only store the password on a trusted computer.

When a remote source is unlocked, the little lock next to the computer name will show as
“unlocked”, and its sources will be listed below.

2.3.5. Lock/Unlock a Remote Source

If you want to lock a computer to prevent other users from controlling it, just click on the
lock. If its sources were used in any of the Viewers, they will not show up anymore.

To unlock it just click on the same lock icon. If the password was saved in the keychain you
won’t be asked to enter it; if not, you will have to enter the password again to unlock it.

—_—

When a remote source is greyed out, it means that the computer cannot be
reached. Check your internet connection, and that MovieRecorder is running on
the remote computer, and that "Remote Control" is enabled in the Settings.

SOFTRGON 22-

record stream play



MovieRecorder User Manual

2.3.6. Redundant Mode
Not available in OnTheAir Video Express.

For redundancy, MovieRecorder 4 offers a "Redundant Mode", so that you can have another

MovieRecorder record at the same time. Ingest will then happen through two separate Macs.
Below we will talk about Master and Slave Macs. The Slave Mac is the one that will follow all

that the Master Mac is doing.

To set this up:
. Set up a Source on the "Master" and "Slave" MovieRecorders to bear the same name. It
may be necessary to change their names. Make sure that the names are strictly identical.

. On the "Master" Mac add the "Slave" Mac as a "Remote Controller" source.

. Then in the list, right click on the Slave Mac (not on the sources themselves) and select
“Enable Slave Mode”.

> NDI Sources

v Remote Controlled

v reels1
Enable Redundant Mode

. Once enabled, you will now see an “S” next to the computer name.
> Local Sources
> NDI Sources

v Remote Controlled

v reels11

Once this is set up, when you record from the "Master" MovieRecorder, if (for example) you
start recording on a Source named "Source 17, and if the "Slave" MovieRecorder also has a
source named "Source 1", that source will start recording as well. Same thing if you stop
recording, etc...

Note that:
. we cannot guarantee frame accuracy — the start and stop of the recordings may be a
few frames off between the two computers

. Only basic controls are slaved. We haven't yet implemented more advanced controls
such as metadata, etc... If you have such a request don’t hesitate to let us know and
we’ll see what we can do.
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3. Set Up Destinations

The Destinations tab opens a panel wherein you can create and setup destinations. By
default there is one destination created. If the panelis not visible, you can reveal it by
clicking on the small icon in the upper right corner.

3.1. Destinations Defined

A destination is:
. a location where you will record the file
. avideo codec
. and other settings that you’ll discover below.

3.2. Creating a Destination

To create a new destination, click on the + icon at the bottom of the Destinations list, and a

popover will show up allowing you to select three main types of destinations:

. QuickTime (with 3 subtypes: None, Segmented or
Classic)

i MXF Destinations
. Streaming (only available when the application QuickTime Destination

"Streaming Center" is installed, and with the

"Softron Streaming Pack" option) Q

QuickTime

You can also duplicate destinations in two ways: X
. Right-click on a destination and select e
"Duplicate" ()
. Drag and drop it while holding the "alt" key streaming
down

By default, destinations chosen in QuickTime will be displayed as “QuickTime Destination”
while those in MXF will be displayed as “MXF Destination”. You can rename them directly in
the list. Just click on the name and leave the mouse there. Note that destination names must
be unique.
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3.3. About the Different Types of Destinations

We can differentiate between three main types:

@& MovieRecorder File Edit

. The MXF and QuickTime destinations will create
files on a local or shared storage. So let's call them
"File based destinations". Check the following article Destinations
to know more about the different destination types
and their advantages.

. The Streaming Destination will create a RTMP
stream to a server. For more information on
streaming, see the following article.

QuickTime Destination

MXF Destination

Streaming Destination

3.4. Setting Up a QuickTime Destination

You may modify the Destinations by clicking on the gear symbol or by double-clicking on
the appropriate destination.

In addition to changing the Destination Name, you may change:

. Location: set where you would like to Ing1-Camera1 Q
save the recording. A o

. Naming & Metadata: set how
MovieRecorder will automatically name Destination Name: | Ing1-Camera1

your files and add metadata to it.
(Metadata is not available in
MovieRecorder Express)

. Edit-while Ingest: set the type of

Location
[Volumes/TV server/REGIA/INGEST/Ing1-(

Erase Existing File(s)

QuickTime Movies created (None, Naming & Metadata
Segmented or C'aSSiC). Name: <No Custom Naming>
Metadata: <No Metadata>
. A/V Presets: Select a recommended or
custom A/V Preset. L DI

None

. Auto Split: Set if you want
MovieRecorder to automatically split the
recordings into multiple files.

e Segmented Expected Duration: 11:00 hh:mm

Classic  Preset Duration: hh:mm

These settings are detailed more thoroughly AJV Preset
in the following pages. Apple ProRes 422 (LT)

A
v

File Type: | mov o] v Write Closed-Captions

Auto Split

Split File Every:
AppleScript
Start of Recording: | <None>

End of Recording: | <None>
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3.4.1. Location
This is where you select where you want to record the video file.

You can also set whether or not you want to "Erase Existing File(s).” When this option is
disabled, and a file already exists in the folder you are recording to, MovieRecorder will
append a number to the file to avoid deleting it. You can set the format and location of that
counter in the custom "Naming" tokens. If the option is enabled, MovieRecorder will delete
the file that has the same name.

You can record to almost any kind of storage. As long as the Volume mounts
on the Mac and you have enough bandwidth to record the number of
channels, you should be good. As usual, we recommend testing with a free
demo version of the application available on our website.

You can measure the read and write speed of storage solutions using
software such as Blackmagic Disk Speed Test or AJA System Test, but
remember that these applications measure the speed at a specific time. You
may want to let the test run for a few days, as there are some things that
can temporarily impact the performances of a storage, such as:

. Some use SSD caches. So if you write small amount of data, the speed
will be huge, but if you write a lot of data for a long period of time,
these caches will fill up, and you will write directly on the slower parts
of the storage.

. They can have some temporary maintenance operations, usually
happening in the middle of the night.

. Copying or duplicating files at the same time will impact performances,
so test a "real life" scenario, with people working on the storage as
usual.

. If you are using a NAS, make sure that the whole infrastructure is

properly cabled, etc... A wrong router or bad cable can ruin a whole
network.

About error handlings on storage:

. If the folder you have selected does not exist when you start recording, MovieRecorder
will create it if it has write permissions to (new in MovieRecorder 4)

. If the Volume is getting full or is not mounted we will show a warning icon next to the
destination.
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3.4.2. Naming

In the Naming and Metadata section, there are two parts. Let’s talk about the “Naming"
function first.

You may set up MovieRecorder to automatically name your files by clicking on the gear icon
to the right of the Name section. A pop-up window will show with the heading “Name
Format.” There will be an empty panel, beneath which are a number of “Tokens” that you
can use to name your files.

Destinations

QuickTime Destination

Q
fe

Name Format:

[ Month v [ Week JI _AVPresetName
Destination Name: QuickTime Destination
Location

/Users/remi/Movies Select...

Erase Existing File(s)

Naming & Metadata

Name: [ Month v %
Metadata: <No Metadata> [ Month v ] ( Day v N Counter v }
[ _Hour N Minute J Second
|_Reel |

Use "/" to automatically create intermediate subfolders using tokens

Edit-while Ingest
None

® Segmented Expected Duration: 11:00 hh:mm
Classic  Preset Duration: hh:mm

Sample: 202 etName

AJV Preset
Apple ProRes 422 S
File Type: | mov < + Write Closed-Captions
Auto Split
Split File Every:
AppleScript
Start of Recording: | <None>

End of Recording: | <None>

Simply drag the tokens you would like to use to name your file into the Name Format
panel, in whatever order you would like the file name to be displayed. For example, if you
would like to name your file by the date it is recorded, you would drag the Year, Month, and
Day Tokens into the panel (plus the Hour, Minute, and Second if you would like to narrow
down the parameters even further).

You can also type any characters in the Name Format area, and these will be added to the
file name.
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3.4.21. "Recording Name" Token

The "Recording Name" token is the name that you set in the Viewer window:

Untitled Recording

If you don’t set any "naming format,” then your file name will be the one displayed in the
Viewer. However, if you set a naming format by using tokens, but do not include the
"Recording Name” token, the recording name in the viewer won’t appear in your file name.

3.4.2.2. "Formatting" Token

Some tokens can be formatted in different ways. These are the ones that have a little arrow
on them (Year, Month, Day, Counter). To change the format, click on the arrow and select the
format. For example, you can choose the Month to be set as “April," or “04”, etc...

Name Format-.

Year v | _|SourceName ¥
2
01

NEL
January

Use "/" to automatically create intermediate subfolders using tokens

[ Year vl Month v ) Week J Day v} Counter v}
[_Hour X Minute N Second JTimecode ]

Sample: 20240305/SourceName_DestinationName.

3.4.2.3. Automatically Create Subfolders

A very useful and unique feature of MovieRecorder is the ability to automatically create
subfolders. To do that add a forward slash (“/“) key where you would like to add the folder to
the file path.

For example, if you wanted to create a
subfolder that holds all of the files within Name Format:

a particular year, and then a subfolder [ Year v JI Month v i Day v JI SourceName B
with the month and day, and then the file —Desthationome ], Recordivghame
name to use first the Source Name, the
Destination Name and Recording Name,
all separated by an underscore, you
would pull Tokens into the Name Format Use "/" to automatically create intermediate subfolders using tokens
panel as follows:

SOFTRGON _28-

record stream play



MovieRecorder User Manual

Sometimes MovieRecorder can automatically append some information to the
file name. For example, if you have one source that records to two
destinations, but in the custom naming you don’t add the destinations token, it
will still be added to the file. Otherwise you could create conflicts and have
two destinations writing to the same file.

3.4.3. Metadata

Not available in MovieRecorder Express.

Metadata are used to add information about the recorded files. The metadata can be
retrieved by Media Asset Management. We cover the metadata part in a specific section
below.

3.4.4. Edit-While-Ingest

You may use MovieRecorder 4 to edit your files (with the QuickTime Container), even as they
are being recorded. You may opt for one of three Edit-While-Ingest destinations: None,
Segmented, or Classic. Everything explained in chapter: Edit-While-Ingest.

3.5. Setting Up an MXF Destination

Not available in OnTheAir Video Express.

For the most part, setting up MXF Destinations is the same as setting up QuickTime
Destination. However, a few features are not available in MXF:

. Metadata may not be embedded into the file — a sidecar must be created, if metadata
is desired.

. All MXF files are generated with the "Open" flag, so they can be used for edit-while-
ingest on editing solutions that support it.

. You may decide between two muxing settings for the codecs: either XDCAM or
Generic OP1a. The difference between XDCAM and Generic Opla is the way we
respect the standard. With "pure" XDCAM, we can only accept audio tracks with
maximum one channel per track and no CC track. With the "Generic Op1a", we are
more flexible but therefore do not strictly adhere to the XDCAM standard.

3.5.1. Edit-While-Ingest with MXF Files

Edit-while-ingest with MXF files is possible too. It is, in fact, the file wrapper that Adobe
recommends to use.

Avid Media Composer supports edit-while-ingest with MXF files too, but please read the
following article to know all that is required.
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3.6. Setting Up an Edit-While-Ingest Destinations

You may use MovieRecorder 4 to edit your files, even as they are being recorded. You may
opt for one of three Edit-While-Ingest destinations: None, Segmented, or Classic.

3.6.1. With Quicktime

. None: With this, you opt not to use the Edit-While-Ingest feature. Note that this type of file
will only be readable when they are "closed" at the end of the recording. This means that if
there is an issue before the file can be closed, the file will not be readable nor recoverable.
This is why we recommend to use either Segmented or Classic modes instead.

Edit-while Ingest

. Segmented: There is no predefined duration

to set. The file is growing upon ingest and is )
a much more modern format that supports B Segmented SECHCEEiss - fllEo
many codecs (such as XDCAM or H.264). Classic  Preset Duration: hh:mm

But:

. The growing files will only work in Final
Cut Pro. Other editing solutions support
segmented movies, but only after the recording is complete.

. Files are not usable during the first 10 seconds of recording, and they are updated
every 10 seconds.

. You cannot use them in the project and see them growing there. You can only see the
portion of the file that was there when you inserted it into the timeline, unless you trim
it manually.

. You cannot use segmented movies to do edit-while-ingest in Multicam clips.

. Classic: With Classic, you have to set a predefined duration, and some codecs (such as
H.264) are not supported. But:

. Classic Movies are growing both in Final Cut Pro and Adobe Premiere Pro.
. You can immediately use the file.

. You can place the whole file (with its predefined duration) in the project and cut it from
there. Note that this works only in Final Cut Pro. The file will not grow in the timeline of
Adobe Premiere, except when using a trick explained in the help center article.

. You can use classic movies to do edit-while-ingest in Multicam clips in Final Cut Pro to
do a live Multicam edit while the recording is still taking place.

You may Edit, Delete, or Duplicate any Destinations you have set up by clicking on the gear
icon on the bottom of the Sources panel and selecting the appropriate action. You can also
delete a Destination by highlighting it and clicking on the “-“ icon.

3.6.2. With Quicktime

Final Cut Pro also supports growing MXF files. There is nothing specific to set here.

Edit-While-Ingest with MovieRecorder works with Final Cut Pro, Adobe Premiere
Pro and Da Vinci Resolve. Information in chapter “Edith-While Ingest”.
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3.7. Stream with MovieRecorder

To stream with MovieRecorder, you need to buy our Streaming Pack.

It allows you to stream from MovieRecorder or MovieRecorder Express, running on the same
Mac. Just create a preset in the "Streaming Center" application and it will be available to use

on multiple channels, the number limited by the capability of your Mac to encode H.264.

Here is an overview of the Softron Streaming Center application

=
o~

@

You can stream to a RTMP or RTSP server, to a Wowza server, or directly to YouTube or
Facebook. For each, you can find information about how to setup your stream on our

f O @

Facebook YouTube Wowza

Preset Name:

Server: | Primary ¢

Stream Key:
Video
Resolution: | Same as source Width:
Framerate: = Same as source Height:

Quality: \A\ Bitrate:

Audio

Samplerate: | Same as source Channels:

Bitrate: 128

Cancel

500 kbps

2

Apply

website.

Once your preset is ready, go back to MovieRecorder and
create a new "Streaming Destination”.

Then click on the "Setup wheel" and select the Streaming
Preset that you have just created.

You can also change the name of the destination so it
describes better where you are streaming to.

Now you are ready to use it as you would with any other
destination in MovieRecorder!
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3.8. Selecting and Modifying A/V Presets

MovieRecorder 4 is capable of recording to many codecs (see our MovieRecorder web
page, under codecs and formats, for the full list). Depending on the chosen codec, you will
be able to record more or less channels (also depending on the format). Indeed codecs such
as H.264 or H.265 (HEVC) are very demanding compared to codecs such as ProRes. Note
that MovieRecorder Express is limited to the ProRes family of codecs, and does not have the
full availability of codecs available in MovieRecorder 4.

3.81. Recommended and User Presets

We have created a set of "Recommended Presets" for most codecs. These cannot be
modified by the user. That way you know that they won’t be modified and correspond to
what is usually recommend (for example, XDCAM has a specific audio configuration that is
required for MXF XDCAM). We tried to limit the list, so we have not done all configurations
possible and some codec flavors are not available as recommended presets.

{3 Q & $

General Metadata Timecode GPI Actions

v RECOMMENDED PRESETS
v Apple ProRes

Apple ProRes 422 (Proxy)
Apple ProRes 422 (LT)
Apple ProRes 422
Apple ProRes 422 (HQ) Codec:
Apple ProRes 4444

AVC-Intra

Avid DNx

DV/DVCPro

H.264
H.264 SD NTSC
H.264 SD PAL Source Crop: 8 Bottom:
H.264 720p
H.264 1080
H.264 UHD 25/30
H.264 UHD 50/60 Rotate:
H.264 Main Automatic Output Resolution: Width:
H.264 High Automatic

H.265 (HEVC)

HDV

IMX

Uncompressed Overlays

XDCAM

v USER PRESETS
User Audio/Video Preset

Audio

General

Effects

Right:

Deinterlace:

Height:

Output Frame Rate:

Text Overlay:

Image Overlay: 8 Offset x:

Offset y:
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But you can create any number of "User Presets" for which you can change the video
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codec, the effects, and audio configuration and mapping.

To create a user preset, you may want to start from a recommended preset. Highlight it in
the list on the left, and then Duplicate it in one of three ways:

. Right click and select “Duplicate”.
. Click on the gear icon at the bottom left of the panel and selecting “Duplicate” from

the popup menu.

« Click on the “Duplicate” button on the bottom right corner of the panel.

Once you do so, a copy of the Recommended Preset will appear beneath the User Presets
area, and the panel to the right will be opened up to allow you to make modifications to the
video, effects and audio settings.

{3

O O

General Metadata Timecode 5 Actions

v RECOMMENDED PRESETS
v Apple ProRes
Apple ProRes 422 (Proxy)
Apple ProRes 422 (LT)
Apple ProRes 422
Apple ProRes 422 (HQ)
Apple ProRes 4444
AVC-Intra
Avid DNx
DNxHD 120/145
DNxHD 185/220
DNxHR LB
DNxHR SQ
DNxHR HQ/HQX
DV/DVCPro
H.264
H.264 SD NTSC
H.264 SD PAL
H.264 720p
H.264 1080
H.264 UHD 25/30
H.264 UHD 50/60
H.264 Main Automatic
H.264 High Automatic
H.265 (HEVC)
HDV
IMX
Uncompressed
XDCAM
v USER PRESETS
User Audio/Video Preset
User Audio/Video Preset 1

User Audio/Video Preset 1

Video Audio
General

Codec: | Apple ProRes

Variant: | Apple ProRes 422

Effects

Source Crop:

Deinterlace:
Rotate:

Output Resolution:

Output Frame Rate:

Overlays

Text Overlay:

Image Overlay:

Bottom:

Right:

Width:

Height:

Offset x:

Offset y:

You may rename the AVPreset name by clicking on the Preset Name box and rewriting it to

whatever name you prefer.
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3.8.2. Video - General Settings

Under the video tab, first select the codec used. Then, depending on the codec selected,
you may have some additional options for that codec. For example, for ProRes you can
select the flavor you want (Proxy, LT, HQ,...) and for codecs such as H.264 you will be able to
set the bitrate, profile level and format.

3.8.3. Video - Effects
Not available in OnTheAir Video Express.

You may also add a number of effects to the file:
. You can crop the recording.
. You can deinterlace the file.
. You can rotate the recording 90°clockwise or counterclockwise, or 180°.

. You can change the output resolution. This is especially useful after cropping a
recording to restore it to an HD format, for example.

. As of MovieRecorder 4.1.3, you may set the aspect ratio to 16/9 in the generated file.

Effects

Source Crop: Top: Bottom:
Left: Right:
Deinterlace:

Rotate:

Output Resolution: ¥ 720x576 C v 16/9 Width:

Mode: | Fill o] Height:

3.8.4. Video-Overlays

Not available in MovieRecorder Express.

You may also overlay Timecode and/ or the Source Name to the recording, or you may
overlay an image (by aligning it as desired, and then choosing a path to the image file).

Video Effects and Overlays can greatly impact performances. So before
enabling any effect or overlay, and start a recording session, make sure that
your computer can sustain the increased resources required. As always run
tests before going into production, using the same type of video signal as you
will be using as performances can vary a lot if the video is more or less complex
to encode.
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3.8.5. Audio

Edit the Audio Setting
by clicking on the Audio
Tab.

Add (or remove) tracks
by clicking on the “+”
icon at the bottom of the
panel, and you may
duplicate channels by
highlighting one and
clicking on the gear icon
then select "Duplicate".

You can also change the
language of the track by
clicking on “English”
and clicking on the
language of choice from
the pop-up selection.
This language will be
assigned to the
QuickTime audio track
created.

General

v RECOMMENDED PRESETS
v Apple ProRes

Apple ProRes 422 (Proxy)
Apple ProRes 422 (LT)
Apple ProRes 422
Apple ProRes 422 (HQ)
Apple ProRes 4444
AVC-Intra
Avid DNx
DNxHD 120/145
DNxHD 185/220
DNxHR LB
DNxHR SQ
DNxHR HQ/HQX

> DV/DVCPro

H.264
H.264 SD NTSC
H.264 SD PAL
H.264 720p
H.264 1080
H.264 UHD 25/30
H.264 UHD 50/60
H.264 Main Automatic
H.264 High Automatic
H.265 (HEVC)

> HDV

IMX
Uncompressed
XDCAM

v USER PRESETS

User Audio/Video Preset
User Audio/Video Preset 1

o & ¢
-
Metadata Timecode GPI Actions
User Audio/Video Preset 1
Video Audio

v Track Languages

Tracks: | Track 1 English 2 Channels fol
Track 2 English 2 Channels £

Click on the gear icon on a track line to change the audio codec settings:

. Change the audio codec: Linear PCM or AAC.

. Then, depending on the audio codec you can choose the bit rate, sample rate and

whether it is big or little endian.

Preset Name: Apple ProRes 422 copy 1

Video Audio

Tracks: Track 1 English 2 Channels
Track 2 English 2 Channels

Codec:

Sample Size:

Linear PCM

24
Big Endian

Click on the "ladder" icon on a track line to change the audio tracks and mapping:
. Adjust the number of audio channels you want to record in that specific track (up to 8).
. Then for each channel you may select which source channel to use, and to which speaker

the audio will be mapped.
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3.9. Using AppleScripts

Location

You may now add AppleScripts to the MovieRecorder
application. You may set this up at the bottom Destinations tab:

If you need more information about Applescripts in
MovieRecorder, go to our website e S
and read this article: “Learning how .
to build AppleScripts”

Auto Split
Split File Fyvery:

AppleScript

Before Recording: | <None>

After Recording: | <None>

3.91. About AppleScript Authorization

Starting with macOS 10.14 (Mojave),
the OS may show a warning when
an AppleScript tries to control some
applications (particularly the ones
with private info). It is not the case
for all Applications, and you will only
know when the AppleScript is
triggered. But you usually don't want
to have a warning showing up
during your shows.

Settings

== ()
& = ¢ 0O &
General A/V Presets Metadata Timecode GPI

AppleScript

/Library/Application Support/Softron/MovieRecorder/AppleScripts

Ouvrir_le_live Authorize

Script lancement live Authorize

This is why we have an "AppleScript"
Setting pane where you will be able
to "Authorize" an AppleScript.

Test Parameter Value:
TestValue

3.911. When Should AppleScripts be Authorized?

Unfortunately it is not very clear as to when an AppleScript will require you to be authorized
to control the other Application. It all depends on the kind of application you are controlling,
and on the kind of info that you are requesting.

Also, you should not have to authorize again after having installed an update, but just to be
sure, you should do that from time to time.

—— Authorizing AppleScripts will actually run the script and do the action. So make
sure that you do not do this authorization during a production, or that the Script
does not have an impact on your production. You could write AppleScripts that you
use only for tests and don't actually do anything but are just used for Authorization.
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3.91.2. Changing the Location of the AppleScripts

At the top of the window, you can see where that AppleScript is located and change its
location by clicking on the "Set..." button.

Settings

O O &

General A/V Presets Metadata Timecode GPI

AppleScript

/Library/Application Support/Softron/MovieRecorder/AppleScripts

Ouvrir_le_live Authorize

Script lancement live Authorize

Test Parameter Value:
TestValue

In the table below you should see the list of AppleScripts that you have placed in the
Actions folder.

3.91.3. About the Test Parameter Value

Before you click on the "Authorize" button, you should first make sure that you have entered
a valid "Parameter" in the text field at the bottom:

Settings

@ = O O

General A/V Presets Metadata Timecode
AppleScript

JLibrary/Application Support/Softron/MovieRecorder/AppleScripts

Ouvrir_le_live Authorize

Script lancement live Authorize

Test Parameter Value:

TestValue

The validity of that parameter depends on the AppleScript. Some of them will require a text,
others a number. In general it's just a test and leaving it to "TestValue" should be just fine for
the purpose of this test.

SOFTRGON _37-

record stream play



MovieRecorder User Manual

3.91.4. What will Happen when you Click on Authorize?

As explained above, we will actually run the AppleScript and it will then do the actions it
should do. (We tried other options, such as just opening the application, but this would not
trigger the authorization, as it will also depend on what you ask the application to do). So
either:
e if the AppleScript performs an action that does not impact your production, just click
on "Authorize".
e if it will have an impact on your production:
e authorize it when you are not in production
e or write another "Test AppleScript" that will do something else, but not impact
your production. Make sure it does still try to control all the applications, and
that this action triggers an Authorization. We have seen that some actions
triggered it and others not. It basically depends on what you are asking the
application.
This is why when you click on Authorize, we will show the following warning:

©)

Warning

This will execute the selected
AppleScript and should not be done
while in production.

Are you sure you want to do this ?

Cancel (0] ¢

Once you have clicked on "OK", a few things may happen:
e the AppleScript will run and not show any window asking you if you authorize to
control another application. You are all good then.
e awindow such as this one will show up. Click on OK. And now you are good.

4,

“MovieRecorder.app” wants
access to control “Mail.app”.
Allowing control will provide
access to documents and data in
“Mail.app”, and to perform
actions within that app.
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3.9.2. Possible Errors

3.9.21. Error with the Script itself

A quick reminder that to work, your scripts should all
start with "on Action (parameter)", and end with "end !
Action". ©
The operation couldn’t be
As the AppleScript runs you may have an actual issue completed. /Library/Application
. . . . . . Support/Softron/MovieRecorder/
with your script, if there is an error in your script, you AppleScripts/SECREC.scpt:

should see the following error. Make sure to correct your execution error: OnTheAir Video
Script got an error: Can't get playlist
pt. "Hello Softron". (-1728)

3.9.2.2. Application not Authorized

L

If in the past you have refused the authorization, the

following error should be shown. The operation couldn’t be
completed. [Library/Application

Support/Softron/MovieRecorder/
AppleScripts/RepeatStop.scpt:

execution error: Not authorised

to send Apple events to Mail.
(-1743)

To overcome that issue, open

" . . [ JOR < > Automation
System Settings > Security &
Privacy > Automation”. Search for @ " (e i A T R RS
MovieRecorder, disclose the @ sound EerioplagtonsiNitiis
content, and make sure to enable et > By BBEdit
the control of the Applications 6 seeentine "B moverecorde
that you want MovieRecorder to &l vai
trol Appearance ail ([ @)
Con M ccessibili
2 IZHY > @ onTheair Video
=) Control Centre
) . © siri & Spotlight
This screenshot on the right
means that MovieRecorder is beskiop & Dock
allowed to control (send & pisplays
AppleEvents) to the "Mail" - Z“a""a":'
. . |\Z) Screen Saver
application. O eetory
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4. Viewers Area: Layout and controlling Sources

41. Setup the Viewers Layout

If you have multiple sources, you can display any number of Viewers (up to 49,
depending on the size of your display) by clicking on the Viewers setup icon
at the top right corner of the window:

Viewers:

Gang Control: @ Only Selected Sources in Viewers

All Sources in Viewers

All Enabled Sources

Select the number of Viewers to be displayed, then select the layout you want to use:

If you enable the option "Size to Fit", the Viewers will fill the size of the MovieRecorder
window. When enabled, the Viewers can be larger than the Window itself and thus you may
not see all sources at once. To resize the Viewers, use the bottom right corner of the first
Viewer, click, drag and drop to set it to the size you need.

Note that we provide a set of layouts but this can be customized. If you don’t see the layout
that suits you, get in touch with us and we’ll explain how to customize the Views to fit your
needs.

From there, as well, you can set up the behavior when you will use the gang controls (see
below the section about gang controlling multiple sources at once).
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4.2. Assign Sources to Viewers

Once sources are enabled, you will be able to assign them to Viewers to see the incoming
format and control the recording for it. You can either:

. Click on the "Select a Source.." menu at the top left of any Viewers. Then select the
Source you want. You can select either a Local, NDI, or Remote Source.

v Select a Source...

DELTA-12G - 6 FAN

DELTA-12G - 7 FAN DELTA-12G -1
DELTA-12G - 2

DELTA-12G - 8 PAN

. Alternatively, you can enable a source with a simple drag-and-drop: click on the source
cell in the sources list, and drag and drop it into any of the Viewers. You can also select
multiple sources at once and drag and drop them to the Viewers area. This will assign
all of them to the Viewers at once, and enable them if they were not enabled yet

4.3. Controlling the Overlays on the Viewers

A great deal of useful information can be displayed on the viewers, including the Timecode,
the recording’s duration (while recording), and VU meters:

lo4K-0-1 ProRes to Movies

04:44:1‘91516 -~ 00:04:48:00

Untitled Recording

(Some Overlays may not be available in MovieRecorder Express, for example, the metadata
and CC icons as these features are not available in MovieRecorder Express)
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You can set which pieces of information is displayed by using the controls in the upper right
corner of the Ul:

« The first icon above is to select the number of viewers that are visible.

VU Meters

. The second icon is used to set up the presence of VU meters. Clicking it
pulls up a pop-up menu, from which you can select how many meters will
be displayed.

> There are three different settings for the VU meter display: off (the
icon will be white on a gray background); on when you move your 18 il
cursor over the viewer (white on a black background); or always on
(blue on a black background).

> Clicking on the icon cycles through the three choices.

I 2

. The third icon is for TC display. As in the VU meters, clicking on the icon
cycles through off; on when moving a cursor over the viewer; or always on.

. The fourth icon allows you to display or hide the information presented in the outer
corners of the viewers: the Source Name (upper left), the Destination Name (upper right),
volume controls (see below) and full-screen (lower right corner), and the metadata tag.
When the icon is blue on a black field, the information is displayed; when white on black, it
is hidden.

4.4. Enabling Destinations

(In MovieRecorder Express, you’ll only be able to enable one destination at a time)

When no destination is enabled for a given source, it shows a warning in the middle of the
viewer: "No Destination Enabled”:

TRICASTER-MINF(MIX1)

Untitled Recording
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Once destinations are configured (see below), you can enable one or more destinations to a
given source.

There are multiple ways to enable a destination for a source:

. Click on "Destinations..." at the top right of a viewer, and enable the destination(s) you
want to use:

Segmented H264, (2 TRICASTER-

Segmented H264
Segmented ProRes
XDCAM QT
Apple ProRes (LT) 1920x1080 MXF XDCAM
i - 29,97fps - square '\ IMX-QT

00:00:42;10 \
- = bl ! DVCPRO50-QT
bedefghikimnopqratuveyz DVCPRO50-MXF

abcdefghijkimnopgrstuvwxyz

abcdefghijklmnopgrstuviwxyz

ProRes To Movies

. In the Destinations list in the left pane, right-click on a destination and select either:

- "Enable On All Sources" to enable that destination on all sources visible in the
viewers.

- "Disable On All Sources" to disable that destination on all sources visible in the
viewers. (Not available in MovieRecorder Express)

- "Solo On All Sources" to enable only that destination on all sources visible in
the viewers (all other destinations will be disabled). (Not available in
MovieRecorder Express)

. Drag and drop a destination on to a Viewer with either of these modifier keys:
- "No modifier keys": the destination will be enabled on the Viewer.
- "Alt": the destination will be "solo" on that viewer, all the others will be disabled.
- "{*": the destination will be enabled on all the Viewers.
- “4+ + alt": the destination will be "solo" on all the Viewers.

The"enable on all” feature only works for local or NDI sources; it does not
work for remote sources.
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Why should | use Multiple Destinations?

Typically, multiple destinations can be useful either for:

. Recording the same codec to multiple volumes, so you have a backup (in case of
hardware failure, for example). If the AV Preset is the same, we will encode the signal
only once, and write the same frames to the 2 (or more) destinations. This means that it
does not use a lot more CPU to encode to multiple destinations.

. Record a High-Res and Proxy. The same source is recorded to two different codecs
and/or frame sizes. So you have one high resolution version together with a lower
resolution that is easier to work with, as it will use less bandwidth

The number of destinations that can be enabled at once will depend on a
few things:

. If you use MovieRecorder Express, you’ll be able to enable just one
destination at a time.

. the computer. The encoding happens on the CPU, so the better the
CPU, the more destinations you will be able to do.

. the format and fps of the signal. Of course you’ll be able to do less
encodings in 4K than in HD.

. the codec used. Some codecs are more demanding than others.
H.264, for example, is one of the most demanding codecs. Some
computers (all the Intel Core i5 and i7 processors) have a hardware
acceleration chip for H.264 encoding of one channel, and one
encoding process can happen on that chip. So, for example, on a Mac
mini, if you encode one H.264 destination almost no CPU will be used.

. the storage.

It is difficult to give exact numbers, especially as they can change with
macOS versions, drivers, hardware, etc... so check on our website in the
tech specs area, or contact us for more information.
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4.5. Other Controls on Viewers

4.51. Audio Preview

Clicking on the Speaker icon at the bottom right of each
Viewer mutes (or un-mutes) your audio on the viewer. Clicking
and holding the Speaker icon opens another window that
allows you to set up your Audio Channels for the viewer.

All ON All OFF

v 1 2
v 3 4
v 5 6
v 7 8

But if you want to control the Volume of all Viewers at
the same time, you can do that at the bottom of the
Viewers window:

4.5.2. Temporary Fill Screen

You can also set one of the Viewer temporarily

to fill the screen by clicking on the Fill screen \ 4/
icon at the bottom right of each Viewer: ~mny ey -
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5. Recording with MovieRecorder 4

51. Basic Controls

Recording is simple and intuitive with MovieRecorder 4. To do so, simply hover your mouse
on a Viewer and click on the corresponding controls that show up.

[ ] == Il |TC

Sources

TRICASTER-MINI(MIX™1) QuickTime Destlnatlon 1

1~5 o 4;4,—.08. TRICASTER PROGRAM r' ﬂ~

» Loca

Untitled Recording

®

Click on the red Record button to start recording (the only button available); the Viewer will
then be circled in red and a "REC" will show up at the top:

[ J == lul TC M |

Sources
TRICASTER-MINF(MIX*1) QuickTime Destination 1

1~5 55: Ov@—v.] 7‘ TRICASTER PROGRAM f(;)(omo 3’:123\

» Local Sources
» NDI Sou

» Remote Controlled

Untitled Recording

QWO

Note that the controls changed slightly and you can now
select:
. Stop recording
. Pause recording (this is only available for "Classic"
destinations) Recording Duration:
. Time the recording: Clicking on the Timer button pulls 00:05 Rl
up a pop-up window that allows you to either finish in End Time:
a certain amount of time, or to end at a certain time.
This is very useful if you don’t want to forget to stop
the recording:
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5.2. Gang Recording

You can set up MovieRecorder 4 to control multiple recordings at once. Once one or more
viewers are selected, gang controls appear on the bottom of the Ul. You can use them to
control all of the selected viewers with the touch of a button.

There are three modes of Gang controls available in MovieRecorder 4. These are set in the
Viewers layout popover:

Only Selected Sources in Viewers: This is
how MovieRecorder 3 used to behave: When
you use the gang controls, only the Viewers
selected (highlighted in blue) will be
controlled. You can use the cmd+A keyboard
shortcut to quickly select all.

All Sources in Viewers: In this case, you
don’t need to worry about the selection, all
the sources visible in Viewers will be
controlled.

All Enabled Sources: Here even Sources
that are not visible will be controlled by the
gang controls. This can be useful if for
example you have used the temporary full
screen feature of one Viewer.

Gang Control: Only Selected Sources in Viewers
® All Sources in Viewers

All Enabled Sources

Below are the keyboard shortcuts that can be used that will have the same behavior as
clicking on the gang controls in the user interface (so it depend on your gang controls

settings):

« cmd + 1: Select/Deselect Viewer 1
. cmd + 2: Select/Deselect Viewer 2

. cmd + #: Select/Deselect Viewer that corresponds to the number

« cmd + R: Record
. cmd + K: Stop
« cmd + P: Pause

« cmd + T: Timer (pulls up the Timer settings window)
. cmd + N: Gang Naming (allows you to name all ganged recordings at once)

. cmd + L: Lock the viewer(s)
- cmd + U: Unlock the viewer(s)
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6. ontroll Remote Sources

To set up the remote control option, go back to chapter “Remote Controlled Sources”.

6.1. Assing sources to Viewers

Remote sources are available as any other sources to be assigned in the Viewers. You can
assign remote sources exactly the same way you assign "Local" sources to Viewer:

o0

Sources

- Either click on the top left of . Ysslect asource::
the Viewers and select the ‘ DELTAhd -1
< DELTA-hd - 2
source from the drop-down DELTA4d-3
¥ MacPro_MovieRecorder1 DELTA-hd - 4
menu: DELTA-hd -1

DELTA-hd - 2
DELTA-hd - 3
DELTA-hd - 4

« Oryou can select them from s -
the list of sources, and drag Sources
and drop themonto a "
viewer. If you drag and drop ' e
multiple sources at once, T
you will see a green outline B
on all the viewers they will et
be assigned to (they will
replace other sources that
were eventually assigned).

« Once Remote sources are added to the Viewers, note that
their name is in italics:

DELTA-hd =1

6.11. Specifics of "Remote Sources”

Remote sources are controlled the same way as Local sources, but with some differences:

« You cannot edit the sources settings, nor the destinations settings. This is by
design, because we wanted to make sure that an "admin" user could do a setup in the
Remote MovieRecorder while the users could only control it, but not change the
important settings.

« You cannot do scheduled recordings or VTR batch captures on Remote sources.
These features may be added in future versions of the application. Contact us if you
need that feature.
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6.2. Remote Control with the Web Ul

You can control a remote computers from any browser, on any type of computer, Mac, PC,
iPad... For that open a web browser such as Safari and enter the IP address of the computer
followed by the port number 8080, for example: http://127.0.0.1:8080/. This should show the

following page:

eoe [ FERENE <
®© > B E 6@

Sources Destinations
Delta-hd 1
Delta-hd 1 (108

Delta-hd
Delta-hd 2 (1080p 60)

Delta-hd 3

Delta-hd 3 (1080p 60)
Delta-hd 4

Delta-hd 4 (1080p 60)
Delta-hd 5

Delta-hd 5 (1080p 60)
Delta-hd 6

Delta-hd 6

Delta-hd 7

Delta-hd 7 (1080p 60)

Delta-hd 8
Delta-hd 8 (1080p 60)

Select a source...

MS1ULTRA
MS1ULTRA-SONOMA (OnThe.

Select a source...

Select a source...

You will then be able to control the multiple local sources available on that computer.

QuickTime Des.: Delta-hd 2
} W a4 38

127.0.0.1

¢ © h O O

MovieRecorder Remote Control

QuickTime Des... | Delta-hd 3
2 = ’
™

Select a source...

Select a source...

Select a source...

Recording Name

Select a source...

Select a source...

Select a source...

QuickTime Des...  Delta-hd 4
B o 28!38

i

04
25

Select a source...

Select a source...

Select a source...

Note that you will only be able to control the Local sources of that MovieRecorder, not the
eventual remote sources that it might be connected to.

If you want to view just one source, you can use this URL instead:
http://127.0.0.1:8080/index_single.html

This would show the
following page, with just
one source:

Important Note: These two
webpages are more of a
sample to show what is
possible to do, it’'s not a
polished solution. The
source code of that page is
available, and you can
modify it at will should you
need to modify them to
your liking.

ece o EEZEM <

© - B B ¢ B -
Sources  Destinations .. g1

Delta-hd 1 14:17:03:03

Delta-hd 1 (1080p 60)

Delta-hd 2

Delta-hd 2 (1

Delta-hd 3

Delta-hd 5
Delta

127004 [SCIN U= Ry a)

{ED MovieRecorder Remote Control

Dotachds : As Our Cities Expand

Delta-hd 8

Delta

MS1ULTRA
MSIULTRA-S
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6.3. Remote control the Schedule

Introduced in MovieRecorder 4.5, there is now a scheduled recordings webpage available at
http://127.0.0.1:8080/schedule/index.html.

This page supports multiple sources, multiple destination assignments, workday/weekday
viewer settings, and much more. There is an explainer video available here.

eee M- < © 127.0.041 ¢ &+

©  MovieRecorder Scheduler ~ New Recording CopyWeek ~ Settings

< > today Feb 4 - 10, 2024 month week day list

Sun 2/4 Tue 2/6 Sat 2/10

10:05 - 12:00 10:05 - 12:00 10:05 - 12:00
10:30 - 1:30 Meeting 10:25-12 Meeting Meeting
News Tonight New
File
11:40- 1:45
New Case Details
12:25 - 4:05
Studio 3

Outside Pit Cam

Information about Scheduled Recordings in the next chapter.

6.4. Remote control with the REST API

In order to do the remote control using a web browser, we use a REST API. You can find
some information about our REST API on our support desk. If you need more info, don't
hesitate to get in touch with us. All the steps are explained in our online article.

On the computer that runs MovieRecorder, you can enter the following url in a Browser:

http://127.0.01:8080/api.html

6.5. Remote control with AppleScripts

MovieRecorder is also AppleScriptable. You can create AppleScripts that control a
"local" MovieRecorder (see sample AppleScript below), but also a distant MovieRecorder.
But the best would be to go for the REST API.

Information about how to use AppleScripts in chapter “Using AppleScripts®.
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/. Scheduled Recordings

You may schedule when you would like a recording to begin and end (at a specific date or
on specific days of the week). Any schedules you have previously set up will be listed on
the panel beneath the Schedule tab; if the box is checked, the schedule is active and the
recording will begin and end as specified.

Schedule

v Scheduled Rec 1:00

0000000 o3
SourceFP=Default MXF Destination

You may create new schedules by clicking on the “+” icon on the bottom left of the panel. A
pop-up window will appear with a number of customizable features.

Recording Name
Scheduled Rec

Type
® Weekly:

Mon Tue Wed Thu Fri Sat Sun
v v v v v v v

Specific Date:

Time (hh:mm)
Start Time: Duration: End Time:
00:00 01:00 01:00

Sources

SourceFP=Default

Destinations

Ing1-Cameral
Ing1-Camera2
¥/ MXF Destination

AppleScript

At Start: | None

At Stop: None

Under Recording Name is a box within which you may enter the name of the recording to
be scheduled.

Below that is the Type of schedule, either Weekly (wherein you would check the boxes
beneath the day(s) of the week you would like to record) or Specific Date (wherein you
would input the date you would like to record). Below the Type is the Time (hh:mm) boxes,
wherein you would input the Start Time and Duration of the recording; the End Time will be
automatically calculated (alternatively, you could input the Start Time and the End Time, and
the Duration would be calculated).

Below that you must select the Source of the recording. Click on the Sources box and scroll
down to and select the appropriate Source. Below that is the Destinations section, where
you may select which destination(s) to which you would like to record.

You may Edit, Delete, or Duplicate any Schedules you have set up by clicking on the gear
icon at the bottom left corner of the Schedule panel and selecting the appropriate action.
You can also delete a Schedule by highlighting it and clicking on the “-“ icon.
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8. Recording with Closed Captioning

Not available in OnTheAir Video Express.

As long as the incoming video signal has valid Closed Captioning (see our article How to Do
Closed Captioning with Movie Recorder for details), the Closed Captions will be included in
the recorded file.

8.1. Setting Up Closed Captioning (CC)

In MovieRecorder, there is nothing much to do. If you have purchased the option, just start
the application, enable one source. If you have a valid signal, and use a valid destination
(see above), just start recording and the file generated will have the Closed Captioning.

8.2. Supported Hardware

Supported hardware:
All AJA and Deltacast devices support Closed Captioning.
With Blackmagic-Design, recording Closed Captioning getting in an input is supported with :
« The devices that support 4K and more will support recording video in 8-bit and
10-bit.
« All other devices will only record closed captioning when recording video in 8-
bit.

8.3. Supported Formats

Note that:

. MovieRecorder 4.1 and later supports recording CC to both QuickTime and MXF
Destinations. (CC is included in the standard application in MovieRecorder 4)

. MovieRecorder 3 records CC only to QuickTime Destinations, not to MXF Destinations
and supports only CEA-708. (CC was a paid option in MovieRecorder 3)

In HD and more, MovieRecorder only supports:
. CEA-708 captions
« the captions must be present in the VANC of the incoming video signal
« MovieRecorder will create a QuickTime closed caption track (CEA-708)
« the supported formats are 1080i29.97 and 720p29.97 or 720p59.94
- downscaling or upscaling, resizing, etc are not supported

In SD, MovieRecorder only supports:
« CEA-608 VBI Line 21 captions

- the captions must be embedded in line 21 of the VBI (Line 21 is the second (field 1) and
third (field 2) lines on a 720*486 video)

« the input must be NTSC
« the destination should use a 720x486 format, it won't work with other frame sizes
- downscaling or upscaling, resizing, etc are not supported
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8.3.1. With CEA-708

When a signal gets in MovieRecorder and there is valid CEA-708 information available in the
signal, we will display a small "CC" icon at the bottom left of the Viewer.

When CC are getting in, they will be overlaid on top of the Viewer. You can disable that by
clicking on the CC icon:

Sources —
OnTheAir Vid MXF Destihation
¥ Local Sources e

¥ OnTheAir Video ® 1 6 : 2 [
-0 %

> NDI Sources

» Remote Controlled

8.3.2. With CEA-608 VBI Line 21

As the Closed Captioning info is "burned in" the video frames, we cannot know that there is
CC info, unless if we analyzed the frame, but this could use some CPU. So the only way
currently is to have a look at the top of the image, and check if you can see the white and
black areas, but it might be difficult to see, also because we can crop a few pixels at the top.

If you cannot confirm the presence of CC in a file, please read our website article “HOW TO:
Record Closed Captioning with MovieRecorder” to have all the information.
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9. Using the Stream Deck Controller

MovieRecorder can be controlled simply using a Stream Deck from Elgato. Different options
exist:

o Use the integration that we have built in our software,
o Or use the Bitfocus Companion and either:
- Some Companion "Modules"
- Our RESTful HTTP AP
- The HyperDeck Emulation
o Or use the software that Elgato is providing.
It will be one or the other.

9.1. Softron Integration

First, start your Softron application. Depending on the application that you use, you will have
different layouts.

If you go to the menu "Window > Show Stream Deck window", you should see a window
such as this one:

o6e Stream Deck

Device Type:
All Types
(© sTREAM DECK
Default (© sTREAMDECK
Classic
Launch Clips
Default

Stream Deck Classic (AL44G1A08592) Stream Deck Mini (BL36H1A26332)

Launch Clips

Default

Launch Clips

There are 2 sections in the window:
o To the leftis the list of available pages, with their names and which kind of Stream
Deck device they are for.
o To the rightis the list of Stream Deck devices that are connected to your computer. On
the screenshot above, there is a "Classic" and a “Mini”

We wanted to allow you to select which device you want to use for each application. Before
you can start using your Stream Deck, you have to drag and drop at least one page from the
list on the left on to one of the device on the right.
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You can also decide to enable the "Hold" option. This option is important for two things:
. if you want to be able to trigger your Softron application, even when using a different
application
- if you are using multiple Stream Decks and you want each to use a different
application

In order to be able to use the Softron integration, you need to make sure that the
"Stream Deck" software is not running. If it is running, it will prevent us to access
the Stream Deck. Make sure that it is not set to automatically launch at startup.

If you need help, check our webpage explaining how to use a the Stream Deck
Controller

911. Customizing the Pages

)
Device Type:
You can create new pages by clicking on the “+” icon at All Types
the bottom of the pages list: Default
Each page can also be modified. For this, right-click on Glassle el

any of the page, and select "Edit": Launch Clips Edit...

Or you can click on the triangle. Duplicate
Default Delete

Launch Clips

When you are editing a page, you will see the device in an enlarged image, with the list of
possible actions on the right:

] Stream Deck

Device Type: >

LAY Play

Stop

| ]
Default © STREAM DECK —

Launch Clips m Pause

< o )
DEET ey | Skip to Previous

UNLOCK » i
Launch Clips e Skip to Next

» « Jump -20s

Default 3 3 208.

« Jump -5s
Launch Clips H 58, P
NEXT

» Jump +5s

58,

Jump +20s

Navigate Up

You can drag and drop actions from one button to another to move them, or from the list to a
button. Click on "OK" when you are done.
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91.2. Customizing the List of Actions

In the edit window, you can create a new action by clicking on the + icon at the bottom of
the list. You can also select an action, right click and select either "New" or "Duplicate" (note
that you cannot edit the default actions).

After a new action is created (or duplicated), click on the "wheel" icon to edit it (or right-click
and select "Edit"). This should open a window:

[ J Stream Deck

Device Type:

25 ciip2s
e © STREAM DECK 26 civ2e

Launch Clips 27 Clip 27

Default -~ 28 cip2s

Launch Clips 29 cip29
Default : ) . ) 30 cip3o

Launch Clips 31 Clip 31
Clip 32 copy 1

Selector: 32 Clip 32
streamDeckPlayClipAtindex:

Parameter: "’ Go to page "Default"
il

Enabled Image: Active Image: 32 ciip32copy1

32 Tu 32

drop images

Cancel Apply

You can set:
- Name: This is the name displayed in the list

. Selector: This is the "action" that will be made. We recommend that you duplicate an
existing action and then edit the parameter, as all possible actions are listed in the list,
there are no other.

. Parameter: Only certain actions support a parameter. This is true for example in
OnTheAir Video to start playing a specific clip, or in Multicam Logger or MIReplay to
add markers.

- Enabled Image: It's the image that is used when the action is not active.

. Active Image: It's the image that is used when the action is active. For example if a
source is recording in MovieRecorder.

Device Type:
All Types

91.3. Restore to Defaults Default

Classic

Launch Clips
The "Restore to defaults" button can be used if you want to

restore to the default configuration. Detaut

Note that this can be useful also if you want to use new Launch Clips
features or buttons that were done in a new version of the

application. It will also copy the new images to the folder. Defautt

Launch Clips
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9.2. Bitfocus Companion

First you will need to_ download the application from Bitfocus's website. Once installed, start

it, and click on the "Launch GUI" button.

Then a few questions will be asked to do the setup; we suggest that you check the
documentation online to set it up the best way to match your needs. In this case, use a

module for MovieRecorder

9.2.1. Using a Module

To control MovieRecorder with Bitfocus, you will
need to find the IP address of the computer where
it runs (check the network settings) as well as the
port number. You can find the different port
numbers either_ in the articles in our help center, or
simply by checking the settings of your application.

. Once you have done the first steps of your
setups, in the "Connections" tab of Companion,
search for "Softron" to show all modules
available.

. Click on "Add" next to the module you want to
use.

. Then configure:

Settings

> 8 ®

nputs  Graphics

Defaults Logs Media HTTP Server
¥ Enable Remote Control

Server Name: mbpm1-pc_OTAV Reset

Port Number: | 8081|

Web Pages Folder: [Library/Application Support/Softron/OnTheAi (/Selectus

Require Authentication:

Base URL for Web Proxies: File Ext.:
http://127.0.0.1:8081 mp4
Base URL for Web Thumbnails:

http://127.0.0.1:8081

HTTPS
Certificate Status:
Certificate Location:

Certificate is missing
ILibrary/Application Suppor..rtificates/tls_certificate.p12 Q
Certificate Password:
Host Name:

The Label = how it will be shown in the Companion settings
Target IP = the IP address of the computer where your Softron application is running
Target Port = the port number used by your Softron Application.

Once this is setup, you should see that the Status is now “Connected”.

127.0.0.1

itftocus Companion

Configuration Wizard

¥ Connections i Buttons @ Surfaces @ Triggers

Emulator

Connections

Web buttons When you want to control devices or software with Companion, you
need to add a connection to let Companion know how to
communicate with whatever you want to control.

Bugs & Features

Label Module Status  Disabled 5[ Warning
Facebook
Disconnected
otav - -
& otav NOT OinsS)_I.j
Slack Chat oftron | N NECTED

Donate

Getting Started
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& Import / Export BLog

+ Add connection & Edit connection
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Target IP Target Port
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Now go to the "Buttons" pane, e
where you will now see the ) s comporion

Presets for MovieRecorder. contpsion iz Y~
Click on the red button, to show T
the different types of actions. .

you will see the different )
"Presets" available to control .m....
EEEE

MovieRecorder. You can now
drag and drop these on buttons
to assign them:

That's it, the buttons should now show up on your Stream Deck. If you want to emulate on
your computer, you can click on "Web buttons" in the left list.

Of course there is more to it, you can then also edit the preset buttons, as these are just
preset, you can modify them to your liking...

9.2.2. Using the REST API

If you want to do actions not available in the MovieRecorder modules, you can use our REST
API. You can find some information about our REST API on our support desk. If you need
more info, don't hesitate to_get in touch with us.

All the steps are explained in our online article.

9.3. StreamDeck Application

We won't go into too much detail, as you can find a lot of info on Elgato's website or on the
web about this, but the idea is that you should first download and install the Elgato Stream
Deck software.

Again, if you use the Softron integration, you should NOT start the Stream Deck software as
it will prevent us to access the Stream Deck. It can be present on the computer, but not
running.
Once installed, you will be able to configure the buttons.
For an integration with the Softron software, you will have to either:

« send REST requests (you will have to know how our REST API works)

« emulate keyboard shortcuts (you will have to know the keyboard shortcuts that you
can use in our application)

The advantage of the keyboard shortcuts, is that it's way easier to do, but the downside is
that you will have to make sure that the application is the front application for the keyboard
shortcut to work. If it's not the front application, the keyboard shortcut might do something
different. The REST requests are a little harder to setup, but will work whether the
application is front or not. All the steps are explained in our online article.
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10. Using GPI Commander with MovieRecorder 4

10.1. Setting Up GPI Commander

MovieRecorder is integrated with GPICommander, and can easily be controlled by that
device. To set it up, go to the top menu “MovieRecorder > Settings > GPI™:

Any connected GPICommanders will be detected by the software and will be displayed in
the GPICommander to Use menu.

Settings

Q &

General A/V Presets Metadata Timecode Actions

GPICommander to use: Use Outputs for:
£ Selection

Inputs 1-16 will control the selection of each Viewer.
Input 22 will trigger a gang record. Input 23 will trigger a pause record and input 24
will trigger a stop record.

Outputs 1-6 will be on when Viewers 1-6 are selected.
Output 7 will be be on when recording is in progress and output 8 will be on when
there is an issue with any recording.

There are 2 ways to use the GPI outputs:

- with the direct integration: you just have to connect the GPICommander box to the
computer and go to the preferences of MovieRecorder to set it up. This is the easiest
way.

- with AppleScripts. This requires you to know how AppleScript work, as well as
installing the software GPICommander, but offers a lot of possibility. For example, you
could control multiple applications with just one GPI trigger.

10.2. Connecting the GPICommander Box

You will need to:
« Connect the GPICommander device to the computer where either MovieRecorder
or GPICommander is running.
« Connect the GPICommander's inputs to your device (it can be a production switcher
GPl/tally output or a simple push button box) using the DB25 connector. Check
the User manual for instructions on how to connect it.
With MovieRecorder you will mainly use the inputs. These 24 inputs are available through a
DB25 connector, where basically and very briefly, an action will be triggered in OnTheAir
Video when any of the first 24 pins is connected to the "ground" (on pin 25).
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10.3. Trigger AppleScripts when Inputs States change

With GPICommander, you can trigger an AppleScript when the state of any of the 24 input
changes. You can trigger an AppleScript when the state changes from closed to opened or
from opened to closed. These AppleScripts can control any application on the Mac that is
AppleScriptable (and MovieRecorder is AppleScriptable).

For this you will need to download the GPICommander application from our website. This is
the application that will trigger the AppleScripts. It is best to learn about the basics of GPI
commander and apple scripting with this article.

The GPI Commander application will have an AppleScript per input. Here is the path to input
1's AppleScript:
/Applications/GPICommander/Actions/Input 1.scpt.

If you need examples of sample scripts, like how to trigger a specific source, or all sources,
to start or stop, go to our website article.

Our GPI commander available on our website shop.

SOFTRGON -60-

record stream play


http://softron.tv/downloads
https://softron.zendesk.com/hc/en-us/articles/115002594014-HOW-TO-Trigger-AppleScripts-with-GPICommander
https://softron.zendesk.com/hc/en-us/articles/115002588833-HOW-TO-Control-MovieRecorder-with-GPICommander
https://softron.tv/products/hardware/gpicommander

MovieRecorder User Manual

11. Edit-While-Ingest

You may use MovieRecorder 4 to edit your files (with the QuickTime Container), even as they
are being recorded. You may opt for one of three Edit-While-Ingest destinations: None,
Segmented, or Classic. The explanations about how to set up in chapter “Destinations”.

111. With Final Cut Pro

~ Disclaimer: This information is provided without guarantee. We are not the coders
of Final Cut Pro, so we can not vouch for its behavior. We can of course vouch for
MovieRecorder's behavior. If you experience issues with growing media in Final
Cut Pro you should contact your Apple representative. Our files are generated in
a "standard" way, and have been working fine since a few years, so there is no
reason they would stop working. Of course you can always contact us, and we will
try to help, but if the issue is that your file does not grow in Final Cut Pro, it's
important to check with them too.

We have seen some issues with files read from SMB storage. They would not automatically
grow in Final Cut Pro. If you experience that issue, try to use a different type of storage.

When you create a new destination with MovieRecorder, you can select a QuickTime or MXF
destination. Both types can work for edit-while-ingest with Final Cut Pro.

111. Segmented or Classic (Quicktime) ?

For edit-while-ingest, if you choose an MXF destination, there is nothing specific to set. If
you choose a Quicktime destination, you can either use Segmented or Classic and here are
the pros and cons of each:

- Segmented: There is no predefined duration to set. The file is growing upon ingest
and is a more modern format that supports more codecs such as the H.264. But,

> Files are not usable during the first 10 seconds of recording. And they are
updated every 10 seconds.

>You can not use them in the project and see them growing there. You can
only see the portion of file that was there when you inserted it in the
timeline, except if you trim it manually

> You can not use segmented movies to do edit-while-ingest in Multicam clips.

« Classic: See below how to configure MovieRecorder. You have to set a predefined
duration and some codecs such as H.264 are not supported but:

> You can immediately use the file

> You can place the whole file (with its predefined duration) in the project and
cut it from there.

> You can use classic movies to do edit-while-ingest on Multicam clips.
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11.1.2. Configure Final Cut Pro

The two limitations indicated below apply ONLY if you intend to copy the files
that MovieRecorder is recording during the ingest. You can choose any option
and disregard these limitations if you copy the files when FINISHED recording as
the files will then just be regular movie files.

In Final Cut Pro
. Do not "Copy files to library storage location", leave them in place.

If you Copy the files to library storage location, Final Cut Pro will copy the file in which
MovieRecorder still writes the frames, and thus this copied file will not be updated. There are
different ways to do this, but we would recommend changing the behavior in Final Cut Pro
“Settings > Import™:

Import

» B N

General Editing Playback Import Destinations

Files: Copy to library storage location

® |Leave files in place

Keywords: ¥ From Finder tags

v From folders

. Make sure that you have disabled all the Transcoding and Analyze options

In the same panel, make sure that none of the transcoding or analyze buttons are checked
for edit-while-capture files. This is because Final Cut Pro may try to transcode or analyze
video frames or audio samples that are not there yet and this could lead to weird behaviors;

Analyze Video: Bali nce color

Fin¢ people

Transcode: Cre ite optimized media

Cre ate proxy media

Lodec:

Frame Size: | 50%
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1.1.3. Setup for "Classic" Quicktime Destinations

In MovieRecorder

You can skip this step and configure MovieRecorder the way you want if you set in and out
points from the media browser of Final Cut Pro and drag only used media to the project (and
do not place media that is not yet recorded in the timeline). But some workflow require to
disable the option "Update Movie Duration when Stopping".

In MovieRecorder, when you configure a destination, in Classic mode, there is an option to

"Update Movie Duration when Stopping”.

If you want to know more about the Classic mode, and what the "Update Movie Duration
when Stopping" option does, read our Website article.

To explain quickly the idea of the Classic mode:

as soon as the recording starts in

MovieRecorder, a file is created to the duration of
what is set in the settings. If you did set the
movie duration to 1hour, the file will have that
duration as soon as the recording starts (without
using the disk space), and this files gets filled by

the new frames coming in.

But if in the end you record only 30 minutes,
here is what happens when you stop the

recording with or without the option:

when the "Update Movie Duration when

Stopping" option is enabled,

MovieRecorder will modify the duration of
the recorded file to the real recording
duration, and not to that theoretical
duration, so you have a file of only 30

minutes.

when the option "Update Movie Duration
when Stopping" is disabled, MovieRecorder
will NOT update the movie duration at the
end of the recording, and you will have
forever a 1 hour file, even if only 30 minutes

was recorded.

The problem with Final Cut Pro with
that option, is that it may refuse is
some cases (see below which cases)
to relink to the file and it will display
this warning:

SOFTRGON
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Destination Name: QuickTime Destination

Location
/Volumes/SharedVolume/MR Select...

Erase Existing File(s)

Naming & Metadata
Name: <No Custom Naming>

Metadata: <No Metadata>
Edit-while Ingest
None
Segmented
e Classic  Preset Duration: ©1:00 hh:mm Loop

v Create New File when Reaching Duration
Update Movie Duration when Stopping

AV Preset
Apple ProRes 422 (Proxy) ¢

File Type: | mov o] « Write Closed-Captions

Auto Split

Split File Every:
AppleScript
Start of Recording: | <None>

End of Recording: | <None>

One or more files could not be relinked.

A modified original file was found in “TestMulticam”
Event, but it could not be relinked.

Relinked files must have the same media type and
similar audio channels as the original files, and must
be long enough to cover all the clips that reference
the files.
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You will then see that Final Cut Pro shows that the file that was being recorded as offline and
has created another clip that has the new duration:

Modified File Modified File Modified File

Untitled Recording 5

Name Content Created
i Untitled Recording 5 15 May 2018 at 11:11:41
4 Untitled Recording 5 15 May 2018 at 11:11:41

If you used only portions of the file in your projects that are still present at the end of the
recording, Final Cut Pro will relink to the file.

111.4. When will Final Cut Pro Refuse to Relink the File ?

This will only happen if you used, in a Project or in a Multicam clip, a part of the file that won't
be present after the duration is modified by MovieRecorder. So in our example, if you used

in a Project only portions of the file that are before the 30 minutes recording, all will be fine.
But if for some reason (for example if you dragged and dropped the whole file to the Project
and edit from there), you have used some parts after those 30 minutes, FCP X will refuse to
relink.

111.5. Edit-While-Ingest with Multicam Files

It is possible to do edit-while-ingest with multi camera files, but only with "Classic" movies.
With segmented movies, the files are not automatically updated in the Multicam clip (they
are updated in the browser).

Also, in your "Classic" destination, make sure that you disable the option to "Update Movie
Duration when Stopping", otherwise you will see the issue explained above and Final Cut
Pro will not be able to reconnect the files.

Once that is done, just import (in place) the files being recorded into Final Cut Pro, and use
them to create a Multicam file as other regular files. Just make sure that your storage as
enough speed to read AND write at the same time the number of channels that you want to
record and edit.
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11.2. With Adobe Premiere Pro

MovieRecorder supports edit-while-ingest with Adobe Premiere Pro (since version CS5.5).
Softron is a Adobe Video Technology Partners.

It is as easy as this: start recording with MovieRecorder, import the file that is being recorded
into Adobe Premiere and start editing. Just make sure to follow the guidelines below...

You can also work with growing files in Adobe Premiere with MovieRecorder Express, but
not with MXF files, only with a "Classic QuickTime" destination.

Disclaimer: This information is provided without guarantee. We are not the coders

~ of Adobe Premiere Pro, so we can not vouch for its behavior. We can of course
vouch for MovieRecorder's behavior. If you experience issues with growing media
in Adobe Premiere Pro you should contact your Adobe representative. Our files
are generated in a "standard" way, and have been working fine since a few years,
so there is no reason they would stop working. Of course you can always contact
us, and we will try to help, but if the issue is that your file does not grow in Adobe
Premiere Pro, it's important to check with them too.

We have seen some issues with files read from SMB storage. They would not automatically
grow in Adobe Premiere Pro. If you experience that issue, try to use a different type of
storage.

11.21. Official Recommendations from Adobe

The best is of course to check with Adobe what they say works. You can find that info in the
following article, under the "Support for growing files" section.

We recommend MXF XDCAM files for the best experience, all other workflows are more
workarounds.

11.2.2. Adobe Premiere Pro Settings

In Adobe Premiere Pro

Go to the top menu “Settings > Media”:

. Disable the option "Write XMP ID to Files on Import" and "Write clip markers to XMP". If
you fail to do so, Adobe Premiere will modify the file that is already being constantly
modified by MovieRecorder and this will corrupt the file.

Preferences

General
Indeterminate Media Timebase: 23,976 fps
Appearance

Audio Timecode: Use Media Source

Audio Hardware Frame Count: Start at 0

Auto Save
Default Media Scaling: None
Collaboration

ControllSurface |_J Write XMP ID to files on import

Graphics [] Write clip markers to XMP

Labels 4 Enable clip and XMP metadata linking

Media 3 Include captions on import
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. Enable the option "Automatically Refresh Growing files". And set it to the value that best
suits your needs. If you want to be really close to the "Live", you can use something like 10
seconds, but if you want to have less frequent updates (and thus easier on the computer),
you can opt for something like 60 seconds.

Preferences

(EE
Indeterminate Media Timebase: 23,976 fps
Appearance

Audio Timecode: Use Media Source

Audio Hardware Frame Count: Start at 0

Auto Save

Default Media Scaling: None
Collaboration i

Control Surface Write XMP D to files on import
Graphics Write clip markers to XMP
Labels Enable clip and XMP metadata linking

Media Include captions on import

Media Cache Enable proxies

Memory Allow duplicate media during project import

e Create folder for imported projects

Sync Settings ) .
Automatically Hide Dependent Clips
Timeline
Growing Files
Trim
Automatically refresh growing files
Automatically resume playback for growing files in Source Monitor

Refresh growing Files Every 10 seconds

Enable hardware accelerated decoding (requires restart)

Enable ProRes hardware accelerated encoding, if available

In MovieRecorder
In MovieRecorder, you will need to make sure to select either:

« MXEF Destination using the XDCAM codec (not with MovieRecorder Express). Adobe
recommends to use MXF XDCAM destinations for growing files workflows, and only
support a specific set of codecs.

«  QuickTime "Classic" Destination

Edit-while Ingest

None

Segmented

e Classic Preset Duration: (1:00 hh:mm Loop

+ Create New File when Reaching Duration
v Update Movie Duration when Stopping

A/V Preset

+ QuickTime "Segmented" destination, using the H.264 or HEVC codec AND the mp4
extension (Adobe Premiere Pro does not support the "Segmented" destinations
using .mov extension for growing files).
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11.2.3. About the Duration of the "Classic QuickTime" Files

Adobe Premiere behaves differently than Final Cut Pro when you import a Classic file. When
you import the file in Adobe Premiere, it will only show only the current recording duration.
Even if you import a "Classic" file, Adobe Premiere will ignore the duration that we have set
to only show the duration of what has already been recorded and this duration will grow
every few seconds when the file grows (the rhythm depends on the refresh interval that you
have set in the Settings).

To overcome that behavior in Adobe Premiere, below are 2 workarounds possible, if you
want to have the file showing up with the full duration in your timeline:

« Create an “Offline File”
« Create an XML

You can find all the information in our website version of this chapter.

11.3. With Blackmagic-Design DaVinci Resolve

Disclaimer: This information is provided without guarantee. We are not the coders
of DaVinci Resolve, so we can not vouch for its behavior. We can of course vouch
for MovieRecorder's behavior. If you experience issues with growing media in
DaVinci Resolve, you should contact your Blackmagic-Design representative. Our
files are generated in a "standard" way, and have been working fine since a few
years, so there is no reason they would stop working. Of course you can always
contact us, and we will try to help, but if the issue is that your file does not grow in
DaVinci Resolve, it's important to check with them too.

We have seen some issues with growing media in DaVinci Resolve, particularly when
reading from SMB drives. Files may not grow in Resolve, and when they do, they can have
some missing frames, and missing audio. When this happens, you may have to quit and
restart DaVinci Resolve. Blackmagic-Design should look into this.

11.3.1.  Which Type of Destination ?

When you create a new destination with MovieRecorder, you can

select a QuickTime or MXF destination. Q
DaVinci Resolve supports growing media only with QuickTime files,
not with MXF.

QuickTime

(©)

Streaming
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Then once you have created your QuickTime destination, there are 2 other settings to
consider:
- the "Edit-while Ingest" setting (None, Segmented or Classic). You can read more about
the different type of destinations here.
« the "File Type" setting (mov, mp4 or m4v) - mp4 and m4v only available in Segmented.

Edit-while Ingest

None
¢ Segmented Expected Duration:

Classic  Przset Duration: hh:mm

AV Preset

Apple ProRes 422 (Proxy) &

File Type: | mov & + Write Closed-Captions

And finally, depending on the type of storage that you use, some destinations will be
recommended. Here's a table of what we have seen to be working.*

Destination type: QuickTime MXF
Edit-while ingest Type: Classic Segmented

File Type .mov .mov .mp4 .MXF
Recommended Codecs ProRes argziS’HEVC EEz\?g ’ XDCAM
Direct Attach ] X
SAN | X
NAS - SMB** i~ X
NAS - AFP*** I~ X

* Results may vary depending on storage type, macOS version, editing software version, and other variables,
this is subject to change, and we recommend testing with a free demo version of MovieRecorder.

** We have seen that Classic movies do grow in Resolve, but sometimes, when getting close to live, we can see
frames where Resolve would say "Media Offline". And this would not go away immediately, making it difficult to
work with.

*** Tested on QNAP and Synology

11.3.2. Which Type of Destination?

In Resolve, open "Settings > Decode Option", and enable the "Automatically refresh growing
files in the media pool" option:

Decode Options

System

Decode Options
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11.3.3. How to work with growing media in DaVinci Resolve

While in theory, the files should be growing in the "Media Pool", we have seen that this was
not the case in version 18.5.1, unless we right-clicked on the "Location" and selected
"Refresh". To work with these "growing media", we recommend to place them in a timeline,
and in "Edit", extend them when they grow.

For example, in the screenshot below, the red line at the end shows that there is no more
media:

01:00:00:00

Video 1
[
@ 223835_Segmented-ProRes.mov
Audio 1
@ 223835_Segmented-ProRes.mov

Audio 2

@ 223835_Segmented-ProRes.mov

But then once the file has grown (Resolve will refresh every 60 seconds), the red line will
turn green showing that there is extra content:

01:00:00:00

Video 1 =S

. = . o !

@ 223835_Segmented-ProRes.mov

Audio 1

@ 223835_Segmented-ProRes.mov

Audio 2

@ 223835_Segmented-ProRes.mov

Then simply drag the end of the clip to extend it.
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12. Working with Metadata

Not available in OnTheAir Video Express.

121. Create and Edit Metadata Sets

You may create Metadata Sets under the Metadata tab of the Settings menu:

Settings

9

General A/V Presets Timecode Actions

Metadata Set: | QuickTime : Title

Title Key: com.apple.quicktime.displayname
Album

D Type: | Text
Author Default Value:
Comment

Copyright

Description

Director

Information

Keywords

Producer

Software

Year

Version

Import... Export...

MovieRecorder 4 comes with a QuickTime metadata set, which you can add more data items
to by clicking on the “+” icon on the bottom left area of the window, and you can remove
data items by highlighting them and then clicking on the “-* icon. You may also duplicate an
item by highlighting another item and clicking on the gear symbol, then selecting “Duplicate”
on the pop-up menu.

You may also create your own metadata sets from scratch by clicking on the Metadata Set
box, then clicking on the Edit option. This will bring up another window showing a list of
previously created metadata sets.

You can add or remove sets by clicking on the “+” or “-“ icons, or duplicate sets by clicking
on the gear icon. If you add a new metadata set, you can rename it by double-clicking on the
“Untitled Metadata Set” and typing in the desired name. You will then need to add your own
metadata items, as described above.

“ o«

Each metadata item can be modified by highlighting the object and then adjusting the
parameters in the right side of the panel. You can change the Name of the item and the type
(your choices are: text, multiple choice, number, date/time, or boolean), and you can set
default values in the Default Value box (by typing the value, or by clicking on the Tokens
button and dragging and dropping the values into the box, or by importing the metadata).

You can also visit our website to read our article: “HOW TO: Add Metadata to your recorded
files”.
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12.2. Enable the Type of Metadata you need in the

Destination
Now that your metadata set is ready, you will
need to configure your destinations to use. Embedded (QuickTime)
You may set up how the metadata for your ¥ Sidecar
recorded files is saved. To do so, click on the Type: [CatDV

gear icon next to your destination. A pop-up Location: @ Same as Movie
menu will appear, with two empty boxes (or
one, if using the MXF wrapper). Clicking the
top box, labeled Embedded (Quicktime), Write: () When recording starts
embeds the metadata into the file (note that When recording starts and stops
this option is only available with the * When recording stops
Quicktime wrapper).

Clicking the Sidecar box creates an XML file that includes the metadata. Do not enable any
of those 2 boxes if you don’t want to create metadata at all.

When creating a sidecar file you can decide a few more settings:

. the format of the XML that will be generated by selecting what Type of asset manager you
would like to use (either Axle, Cantemo Portal, or CatDV).

. the Location of the Sidecar file. Either set it to be the same location as the Movie file, or
choose another path entirely.

. when, during the recording process, you would like to create the sidecar file

12.3. Set the metadata for the source

With your metadata set configured and your destination set, now you are ready to add some

metadata values to your recordings.

. First make sure that the source uses the destination you have set with the metadata type

you need to record.

At the bottom left corner of each Viewer you will see a "tag" icon. Click on it to reveal the

metadata popover window.

. At the top of the window, select the metadata set you want to use. Then below, if you want
to use the "default" value you have set in your Metadata Set, you don’t need to do
anything. If you want to add a different value, simply enable the checkbox in front and
change the Value. To revert to the default value, just uncheck the checkbox.

. Then make sure to click on
"Apply". If you don’t your
modifications will be lost
when you close the popover

Untitled Recording

QuickTime

window. Tite
Album
Artist
The Reel number at the Author
bottom is a specific metadata item that Comment

is written in the Timecode track of your Copuriant
Description
quicktime Movie. It can also be used as Director
a token in the custom naming feature. neet: [0
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13. VTR Control

Not available in OnTheAir Video Express.

With MovieRecorder 3.4, we reintroduced the ability to control a VTR from the user interface.
We have done so because of the huge interest that our users have showed to be able to
capture their sometimes very large libraries of video tapes. And MovieRecorder with its
ability to record multiple channels on one Mac has proved to be the ideal solution for that.

13.1. Hardware needed

You will need either:

- avideo device that has a RS422 port that supports the Sony VTR Control Protocol
(check the AJA or Blackmagic-Design website to know which devices includes this
port).

- if your device does not have that (or as the AJA lo 4K, it only has one port but multiple
inputs are possible), then you will need to purchase a USB to RS422 adapter. We
sell those adapters and have two models:

« amodel with one port

« amodel with 4 x RS422 ports (SerialCommander), so you can control 4 VTRs
with just one device. If you use an MI80 and want to control 8 VTRs from one
Mac, you will have to purchase 2 x SerialCommanders with 4 RS422 ports.

13.2. Setting Up the Source

» Before you can capture, you v Local Sources
need to change the timecode v 8KPro_A_01
source for each source that will DeckLink 8K Pro [...V 8-bit Rec 709)
need to control a VTR.

Source Name: | 8KPro_A_01

« Select one of the ports available Vidbo Settings

In the RS422 section: Video Format: & Automatically detect input format
o If you own a serial commander, Pixel Format: (YUV/8bits  ©

the serial ports will be listed as Color Space: [Auto Detect @

"usbserial-FT..." ¥ Enable Captions & VANCs

Audio Settings
Source: Video Device Audio
Audio Channels: |16 <

Sample Size: | 32 <

Timecode Settings

Source: usbserial-FTXRIWBBO

Offset: 0 £ frames
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13.3. Controlling the VTR

As soon as you have selected the appropriate RS422 port, in the Viewer of the source, you
should see the TC corresponding to the TC of the VTR.

To control the VTR:
- make sure that the VTR is in "Remote" mode and the RS422 cable properly connected
. open the left pane with Schedules and VTR, and select the VTR section

- inthe Viewers area, select the "Viewer" with the source you want to control (it will be
circled in blue). Note that you can only select one Viewer at a time, if you select 2,
the VTR area will show "Multiple Selection”

The window will then look like this: )

8KPro_A_01 00:32:10:04

At the top left you can see the name of the current source that you s W 1
control. Note that you can simply click on this name to switch the 5 :
source that you are controlling (instead of changing the selection in
the Viewer area).

At the top right is the current TC (if the VTR is in "Local" mode it will be
shown there).

You can then control the VTR using either:
« the on screen buttons or the slider for jog/shuttle

VTR

v 8KPro_A_01 04
MS1ULTRA-SONOMA (OnTheAir Video)
n uf i

- keyboard shortcuts:

Keyboard Action

J Go backwards (press multiple times to go quicker)
K Pause
L Go forward (press multiple times to go quicker)
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Logging Clips

To log clips, first set in and out points of a clip to capture. You can either simply enter TC
values in the in/out/duration fields or you can control the VTR, check the in and out points
you need and use either:

« the on screen buttons
- keyboard shortcuts:

Keyboard Action

I Set an in point

@) Set an out point
shift + | Go to an in point
shift + O Go to an out point
alt +1 Clear the in point
alt+ 0 Clear the out point

Once you have set in and out points,

enter a Reel Name, and a Description. In ut DOEHon
22:49:00 22:54:21 5:21

Then click on "Log" or use the Reel: MyReel 2

keyboard shortcut "alt + L". Note that Name: Clip 2

all clips will be arranged by "Reel":

¥ MyReel 1
Clip 1 21:50:13 21:55:00
Clip 2 22:24:00 22:31:03
¥ MyReel 2
Clip 1 22:49:00 22:54:21
Clip 2 22:49:00 22:54:21

10.3.3. Batch Capture

Once you have created all the clips you want to capture, at the bottom of the window, click
on "Capture all". Note that you can capture just a few clips by selecting them and then
clicking on "Capture Selection". MovieRecorder will start capturing the first reel in the list.

When the source is capturing, a few things will happen:
. the VTR area will be greyed out (you can not control anything during that process)
« onthe Viewer will be displayed a "Lock" instead of the stop/pause/record so you can
- not stop inadvertently the recording (right-click on the viewer to unlock)
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Also, when cueing the tape, this will be shown on top of
the viewer:

And when it is currently recording a clip, it will show this:

During and after the recording, the clips will change the status in the list:

« Ared RECicon whenitis
recording

« A green checkmark when it
was captured without errors

« Avyellow attention sign when
it was captured with errors
(drop frames, ...)

- Ared attention sign when it
was not captured at all (TC
not found, destination not
valid, etc)

Abort Capture

If you have entered multiple Reel names, MovieRecorder will ask you each time to enter the
new tape. Note that you should not even need to click on "continue", as MovieRecorder will
detect when a new tape is inserted and continue by itself.

You can abort the capture at any time by clicking on the "Abort Capture" at the bottom of the
VTR Area.

10.3.4. Clear Status and Reveal in Finder

After the recording, you can Name: Clip 2
change the status of the clips
from recorded to unrecorded

by right-clicking on the list and | [EEEE———
Clip 2 22:24:00 22:31:03
¥ MyReel 2
Note that you can also select Y Clear Status

"Reveal in Finder" to show the _ Reveal In Finder [

Captured Cllp Z2.49.0U 22:54:21
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14. Saving and Restoring Configurations
Not available in OnTheAir Video Express.

After setting everything up for a production, you may want to use the same configuration for
a future event. Doing so is as simple as clicking “MovieRecorder > Save Configuration As...”
This will bring up a pop-up window to enter and save the name of the Configuration.

The next time you need that, or a similar, configuration, you can pull it back by clicking on
“MovieRecorder > Restore Configuration”, and then clicking on the desired configuration.

Save Configuration As...
Restore Configuration
Reveal Configurations Folder in Finder

Afternoon Show

The Tonight Show
This is morning!

Quit MovieRecorder #Q

A pop-up window will appear allowing you to select which parts of the configuration you
would like to recall: the sources, Destinations, AV Presets, Viewers Layout, Scheduled
Events, and/ or the VTR Batch List.

Restore Configuration

Sources Viewers Layout
Destinations Schedule Events
Audio Video Presets VTR Batch List

Restoring to a previous configuration can delete some of your
items. And this can not be undone.

Cancel Restore

After you select the desired items, click on the "Restore” button and MovieRecorder will
reconfigure itself to meet those requirements. The next time you request that same
configuration, the pop-up window will appear again, with the same items enabled (though
you may disable individual items if you desire), and you can quickly restore that
configuration again.

You may also wish to find where the Configuration file is kept, and can do so by clicking on
“MovieRecorder > Reveal Configurations Folder in Finder”.

Below is a screenshot depicting the location of the Configuration commands:

@ MovieRecorder Edit View Window
About MovieRecorder...

Preferences...
Licenses...

Services

Hide MovieRecorder
Hide Others

Save Configuration As...
Restore Configuration >
Reveal Configurations Folder in Finder

Quit MovieRecorder #Q
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15. When Something Goes Wrong...

While we strive to ensure that MovieRecorder is as stable a platform as is humanly possible,
there is a lot of interaction between our software and other pieces of your workflow (your
MacOS, video card drivers, switchers, etc.), and so we must constantly evolve our product to
adapt to changes made in those applications. As such, bugs do sometimes sneak up on us.
Should any issues arise while using MovieRecorder, the first place to look for answers to
potential causes is our white pages on our Softron Support Desk website.

Keeping an eye on the Performance Gauges in the Activity & Logs window (accessed via
“Window >Show Activity & Logs Window?”) is also a valuable resource.

The Performance Gauges show the performance of your computer as it runs the application,
and may prove a useful indicator as to what could be causing issues. See our
Troubleshooting: The Log Window Explained article for details.

And also keep in mind that for the life of the product your application includes our support
service. The best way to reach us is via “Help>Contact Support” in the user interface of the
application (see below for image). Through that button you can collect the technical logs
from the application and open a support ticket on our Support Desk. It is important that
when opening a ticket that you supply as much information as possible, including the date
and time of the incident(s).

Help

Contact Softron Support...
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